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Tutorial Outline

Time (Tentative) | Module Topics
8:30-9:00 1. Eclipse & PTP + Installation of Eclipse and PTP
Installation (can start early as people arrive)
9:00-9:30 2. Introduction & + Eclipse architecture & organization
Overview overview
9:30-10:30 3. Developing with + Eclipse basics; Creating a new project
Eclipse from CVS; Local, remote, and
synchronized projects
+ Editing C files; MPI Features; Building w/
Makefile
10:30-10:45 BREAK
10:45-11:45 3. Developing with Continue from before the break...
EC”DSG_ + Resource Managers and launching a
(continued) parallel app
+ Fortran, Refactoring, other Advanced
Features
11:45-12:00 4. Wrap-up + NCSA HPC Workbench, Other Tools,

website, mailing lists, future features




Module 1: Installation

+ Objective
+ To learn how to install Eclipse and PTP

+ Contents

+ System Prerequisites

+ Eclipse Download and Installation of “Eclipse IDE for
Parallel Application Developers” — parallel package

+ Installation Confirmation

+ Updating the PTP within your Eclipse to the latest
release

Module 1 1-0



About the Tutorial Installation

+ This tutorial assumes you have Eclipse and PTP pre-
installed on your laptop

+ If you already have Eclipse installed, go directly to
“Starting Eclipse”, slide 5

+ If you don’t have Eclipse installed, you will need to

follow the handouts so that you can catch up with the
rest of the class

+ Note: up-to-date info on installing PTP and its pre-reqgs
is available from the release notes:

+ http://wiki.eclipse.org/PTP/release_notes/5.0

+ This information may supersede these slides
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System Prerequisites

+ Local system (running Eclipse)
+ Linux (just about any version)

+ Mac OS X (10.5/Leopard or later)
+ Windows (XP or later)

+ Java: Eclipse requires Sun or IBM Java
+ Only need Java runtime environment (JRE)
+ Java 1.6 or higher
+Java 1.6 is the same as Java SE 6.0

+ The GNU Java Compiler (GCJ), which comes
standard on Linux, will not work!

+ Open]DK, distributed with some Linux distributions,
has not been tested by us but should work.

+ See http://wiki.eclipse.org/PTP/installjava
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Eclipse Packages

+ The current version of Eclipse (3.7) is also
known as Indigo

+ Eclipse is available in a number of different
packages for different kinds of development
+ http://eclipse.org/downloads

+ With Indigo, there is a new package directly
relevant for HPC:

+ Eclipse IDE for Parallel Application Developers
+ This is recommended for all new installs

g Eclipse IDE for Parallel Application Developers (includes Incubating
W components), 184 MB

Downloaded 39,008 Times Details

Package”

+ Can also add PTP to an existing Eclipse
installation
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Eclipse Installation

+ Download the Eclipse IDE for Parallel
Application Developers package
+ http://download.eclipse.org

+ Make sure you match the architecture with
that of your laptop

+ If your machine is Linux or Mac OS X, untar
the file
+ On Mac OS X you can just double-click in the Finder
+ If your machine is Windows, unzip the file

+ This creates an folder containing the

executable as well as other support files and
folders
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Starting Eclipse
+ Linux

+ From a terminal window, enter
“<eclipse_installation_path>/eclipse/eclipse &”

+ MacOS X

+ From finder, open the

folder where you installed
+ Double-click on the

application
+ Or launch from a terminal window instead (like Linux)

+ Windows

+ Open the folder

+ Double-click on the executable
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Specifying A Workspace

+ Eclipse prompts for a workspace location at
startup time
+ The workspace contains all user-defined data

+ Projects and resources such as folders and files
+ The default workspace location is fine for this tutorial

| = Workspace Launcher =l
The prompt can be Select a workspace
Eclipse Platform stores your projects in a folder called a
tU N Ed Off workspace.
Workspace: [ ome/beth/workspace) v ! Browse...

[] Use this as the default and do not ask again

( OK “ Cancel \
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Eclipse Welcome Page

+ Displayed when Eclipse is run for the first time
Select “"Go to the workbench’,
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Check Installation Details

+ To confirm you have installed OK
+ Mac:
+ Others:

+ Choose Differs

+ Confirm you have the following installed  depending
software on base

download
e OO0 Eclipse Installation Details
m Installation History Features Plug-ins = Configuration |
Name Version Id

> ‘if Eclipse IDE for Parallel Application Developers 1.4.2.20120213~-... epp.package.parallel

+ Close the dialog:
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Checking for PTP Updates

+ From time-to-time there may be newer PTP
releases than the Indigo release

+ Indigo and “Parallel package” updates are released
only in Sept and February

+ PTP maintains its own update site with the
most recent release

+ Bug fix releases can be more frequent than Indigo’s
and what is within the parallel package

+ You must enable the PTP-specific update site
before the updates will be found

Module 1 1-9



Updating PTP

+ Enable PTP-specific update site s —
+ Help>Install New Software... woiciommmi -l
* CI iC k Ava i I a b I e SOftwa re Work with: °_ type or select a site v A
S iteS I i n k Find more software by working with tfe "Available Software Sites" prefyrences

+ Ensure this checkbox is selected for the PTP site:
http://download.eclipse.org/tools/ptp/updates/indigo

+ Choose OK
+ Choose Cancel (to return to Eclipse workbench)
+ Now select Help>Check for updates

+ If you see “No updates were found”...

+ It’s only because there are no updates in the
“Eclipse IDE for Parallel Application Developers”

+ We will update the PTP within it

Module 1 1-10



Updating PTP (2)

+ We will get the PTP release that is more recent than what
is currently (Nov. 2011) within the parallel package
+ Now select Help>Install New Software...

+ In the Work With: dropdown box, select the PTP update
site you confirmed already:

1800 Install

Available Software |
D3

Check the items that you wish to install.|

Work with: PTP;http://download.eclipse.org/tools/ptp/updates/indigd 'l ( Add.. )

e

Find more software by working with the "Available Software Sites" preferences.

type filter text

Name Version

(] » 000 Fortran Development Tools (Photran)
(] » 000 Parallel Tools Platform
(] » 000 Remote Development Tools
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Updating PTP (3)

+ Quick and dirty:

+ Check everything - which updates existing features and adds a few more

'Name

[Z] » (U0 Fortran Development Tools (Photran)
™ » 000 Parallel Tools Platform

™ » 000 Remote Development Tools

+ Detailed:

+ Open each feature and check the ones you want to update

+ Icons indicate: Grey plug: already installed
and up to date = :
Double arrow: can be updated U == PTP Parallel

Color plug: Not installed yet ¢ "% PTP Parallel
' ial i U J* PTP Parallel
Note: For this tutorial, install GEM and TAU

4 f{f:‘c PTP External Tools Framework TAU Extension
4 < PTP External Tools Framework TAU Extension for Fortran
[ﬂ -{[ LPTP Graphical Explorer of MPI Programs (GEM)

Note: if conference network is slow, consider unchecking:

@ Contact all update sites during install to find required software
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Updating PTP (4)

+ Select Next to continue updating PTP
+ Select Next to confirm features to install
+ Accept the License agreement and select Finish

MNP Installing Software

1 Installing Software

Installing org.eclipse.ptp.pldt.upc

Wait for installation to
finish

[ Always run in background

Run lor
-
( Cancel ) [ Details >> ) ( Runin Backgroundj_y

If conference network is
too slow, we have this
. YoYe Software Updates cached on USB

You will need to restart Eclipse for the installation changes to take effect. You may
try to apply the changes without restarting, but this may cause errors.

+ Select Restart Now when prompted

Not Now ) Apply Changes Now ) ( Restart Now )
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Restart after Install

[ YeNe) C/C++ - Eclipse - }U;;;;/i)é{h/Docum;nrt;/rwrorkspace; -

& &% [y G SR E ) 2D R R =) O U~ & f@c/c++

If any top_level (25 Project Explorer &2 =0 = 0|50 X\ ET|™
=& -
An outline is not available

features are installed...
Welcome page informs
you of new features
installed

We only updated PTP,
SO W e | a n d b a C k a t C/ C + + E_i[:::uems 83\ ¥ Tasks | B Console| I Properties | & Remote Environments
Perspective

... Ready to go!

Help>About or Eclipse > About Eclipse ...
will indicate the release of PTP installed

Further Help>Check for Updates will find future updates
on the PTP Update site
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Module 2: Introduction

+ Objective

+ To introduce the Eclipse platform and PTP
+ Contents

+ New and Improved Features
+ What is Eclipse?

+ What is PTP?
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New and Improved Features

+ More flexible projects

+ Synchronized projects overcome many problems of
remote projects

+ Allows development when “off-line”
+ Works with non-C/C++ projects

+ More customizable resource managers
+ Resource managers can now be added by users
+ Able to have site-specific configurations

+ Interactive launch using job schedulers now
supported
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New and Improved Features (2)

+ Scalable system/job monitoring

+ New perspective allows monitoring of systems of
virtually any size

+ View shows location of jobs on cluster
+ Active and inactive jobs views

+ Remote support for performance tools

+ External Tools Framework has been extended to
support remote systems

+ Performance tools such as TAU can now launch and
collect data from remote systems
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What is Eclipse?

+ A vendor-neutral open-source workbench for
multi-language development

+ A extensible platform for tool integration

+ Plug-in based framework to create, integrate
and utilize software tools

Java C/C++/Fortran Test and
Development Development Performance Parallel Tools
Tools Tools Tools
Platform
Equinox
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Eclipse Features

+ Full development lifecycle support

+ Revision control integration (CVS, SVN, Git)
+ Project dependency management

+ Incremental building

+ Content assistance

+ Context sensitive help

+ Language sensitive searching

+ Multi-language support

+ Debugging
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Parallel Tools Platform (PTP)

+ The Parallel Tools Platform aims to provide a highly
integrated environment specifically designed for parallel
application development

4+ Features include:

+ An integrated development environment (IDE) that
supports a wide range of parallel archltectures and runtime
systems

+ A scalable parallel debugger

+ Parallel programming tools
(MPI, OpenMP, UPC, etc.)

+ Support for the integration
of parallel tools

+ An environment that simplifies the e, B
end-user interaction with parallel systems | "o
+ http://www.eclipse.org/ptp

o dest
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Eclipse PTP Family of Tools

Coding & Analysis
(C, C++, Fortran)
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How Eclipse is Used
Editing/Compiling

(] v ¥ O Q- | [Fr &S

=EM

[ Fortran Projects &2

Fr | & & | @&~ v Gy B Gy o =

= 0O g% outline 2

end module Mdataset

>bstfit.F90 1.1 (ASCI|

program BstFitProj
|3 .cvsignore 1.1 (ASCI

& D |26 errors, 0 warnings, 0 infos

. Description
P =S org.eclipse.photran-samples = =

P = whatever2 @ Derived type definition has no components

'valsum' at (1) already declared at (2)
@ FILE tag must be of type CHARACTER

@ lllegal preprocessor directive

[« o) |G ]

=) <)> -4 B e R e s et Sy B S laz N \Qs o v
— _l\odule Mdataset B! —
b EEMMFP = implicit none DE ¥ () Mdataset =
¥ g >org.eclipse.photran-sam v Tdataset
L4 9 pse-p P ! Declare a Tdataset type to hold data points o
b <& Binaries type :: Tdataset ¢ datapt
b 4 src-fixed-form real :: datapt(4,1000) * npts
integer npts
D 5 src-fortran-and-c %) real valsum(4) ¢ valsum
D (4 src-gaussian-elimination B KAl AL SUM(A) ¢ valsum
real xysum(3) .
D src-includes | logical :: has_np(2) xysum
D (4 src-language-features end type Tdataset ® has_np
< i >src-line-fitting

< ¢ BstFitProj
“  LoadDataSet

“  ShowDataPoints

b (8 src-modules [+)/|® .. use Mdataset = ¢ squareDistances [v]
G o T ) (] ] [) L T [»)
(@ Make Targets &2 = O [Z! Problems 2 " Console Properties *» v =08

Resource IZ]

bug138221.f
bstfit.F90 D
bugl118974.f
bu9118961AfE]
D]
Cg
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How Eclipse is Used
Launching/Monitoring

86400 2011-... 2011- 2 RUNNING
86400 2011-... 2011 4 RUNNING
86400 2011-... 2011 4 RUNNING
86400 2011-... 2011 4 RUNNING
8640 2011 4 RUNNING
4 RUNNING
4 RUNNING
4 RUNNING

4 RUNNING .

1 RUNNING 4

ING M

=0

]
]
]
1]
[} 2 RUNNING
86400 2011-... ? 4 SUBMITTED
86400 2011-.. ? 1 5UBMI
86400 2011-.. ? 1 SUBMITTED |
S| 86400 2011-... ? 1 SUBMITTED ’
86400 2011-.. ? 1 SUBMITTED = LI
86400 2011-.. ? 1 5UBMI
86400 2011-... ? 1 SUBMITTED
8 ? 1 SUBMITTED
2 SUBMITTED N
8 SUBMI v
F)<l>
. [s]

Source Code
Executable

N~
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How Eclipse is Used
Debugging

OO Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/ )
i ‘ w09 | O - Gy [ B Parallel Debug 238 Parallel Runt... FZiRemote C/C... »
% parallel Debug 53 B @[3 ‘(ﬁ {} (4 [ {2+ = O|/9 Breakpoi |67 Expressi |09= variables $3 . 5s Signals | {1} Arrays | 9= variables| = O
Open_MPi@abe.ncsa.uiuc.edu: default:;job0 - Root [4] %0 i
£3 job0 @y Name Value
% arge 1 0
> & argy 7Hfftffd658
@ pi 5.957805E-39
%5 Debug 53 5 0> [~ =08) renr (0- 18]
¥ §} shallow [Parallel Application] Fou (0-18]
v &@Process 0 RO, (0-18] 4
v ® Thread [1] (Suspended) Peesi o-18 Sy4s b
1 main() main.c:38 4032ca
1€ main.c 2 = O|[ 5= outline % =0

12 MPI_Datatype * setup_res();

‘main (argc, argv)
5 int argc;
36 char * argv[l;

{
» 3¢ float pi=4.*(float)atan((double)1.);
) float p[nlml; /* Pressure (or free surface height) */
float u[n][m];  /* Zonal wind */
float v[n][m];  /* Meridional wind */

float psi[n][m]; /* Velocity streamfunction */
float  pold[n][m];
float  uold[n][m];
float vold[n][m];
float  h[n][m];

float  z[n][m];

float  dummyl[m];

float  dummy2[n][m];
float  tpi-pispi;
float  di-tpi/(floatdm;
dj=tpi/(float)n;

B console @ Memory | [£( Problems
Open_MPi@abe.ncsa.uiuc.edu:default;jobd

Module 2

BRY o %[~
math.h
mpi.h
stdio.h
W decs.h
£+ worker() : void
++ setup_res() : MPI_Datatype*
°
°
°

main(int, char*{])
setup_res() : MPI_Datatype*
update_global_ds(MPI_Datatype

Open Mpi Job =@

Source Code
Executable
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How Eclipse is Used
Performance Tuning
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Module 3: Developing with Eclipse

+ Objective
+ Learn basic Eclipse concepts: Perspectives, Views, ...
+ Learn about local, remote, and synchronized projects
+ Learn how to create and manage a C project
+ Learn about Eclipse editing features
+ Learn about Eclipse Team features
+ Learn about MPI features

+ Learn how to build and launch an MPI program on a
remote system

+ Learn about Fortran projects
+ Learn about searching, refactoring, etc.
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Contents

Basic Eclipse Features (3-2)

Projects In Eclipse (3-13)

Editor Features (3-24)

Team Features (3-34)

MPI Features (3-40)

Synchronizing the Project (3-56)

Building the Project (3-62)

Running: Resource Manager Configuration (3-69)
Running: Launching a Job(3-82)

Advanced Features: Searching (3-90)
Fortran Specifics (3-99)

Advanced editing: Code Templates (3-108)
Refactoring and Transformation (3-113)

++++ 4+ 4
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Basic Eclipse Features
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Eclipse Basics

+ A workbench contains the menus, toolbars, editors and
views that make up the main Eclipse window

+ The workbench represents
the desktop development

environment

+ Contains a set of tools
for resource mgmt

+ Provides a common way
of navigating through
the resources

+ Multiple workbenches
can be opened at the
same time

+ Only one workbench can
be open on a workspace
at a time

Module 3
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= 0|[g = = Outline 23 M, g =08
e RN o %Y
1d H stdio.h
= stdlib.h
@ main(void) : int
. =
lude tdio.h>
view
int main(void) {
puts("!!!1Hello World!!!") *
return EXIT_SUCCESS;
}
ditor
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Perspectives

+ Perspectives define the layout of views and
editors in the workbench

+ They are task oriented, i.e. they contain

specific views for doing certain tasks:
+ There is a

for manipulating
resources

+ C/C++ Perspective for manipulating compiled code
+ Debug Perspective for debugging applications

+ You can easily switch between perspectives

+ If you are on the Welcome screen now, select
&

“Go to Workbench” now

Module 3
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Switching Perspectives

arch  Project Run m Help

C/C++ New Window |Eclipse SDK
Fv G - ® |38 New Editor =E

Show View

+ Three ways of changing
perspectives

ame | Customize Perspective...
Author  Save Perspective As... }
Jersiol  Reset Perspective...

Lopyrit - Close Perspective

" Close All Perspectives
' Navigation >
#include =statoThs
1. Choose the

Open Perspective

Perspective menu option s .
Then choose Other... mocH

CVS Repository Exploring

%> Debug
2. Click on the O P tive button in th §PTP Debug
: ick on the Open Perspective button in the 5 pTP Runtime
upper right corner of B Resource
screen (hover over it to £0 Team Synchronizing

SE€E names —
) \B 858 Parallel Runt.., C/C++

3. Click on a perspective
shortcut button

+ Switch to the C/C++ Perspective

[ OK ] \ Cancel
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Which Perspective?

+Which Perspective am in in?
See Title Bar

: C/C++ - MyHelloProject/src/MyHelloProject.c - Eclipse SDK -
File Edit Sourte—TRefactor Navigate Search Project Run PAPI Window

J[‘_Jv[‘ﬁﬂ 1= @J@v aYv IEJ’V G’VJQV §)VJ$V OV ggv %\/JOVJ
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+ The workbench window is = e
divided up into Views =S
+ The main purpose of a view is:
+ To provide alternative ways of presenting information

+ For navigation
+ For editing and modifying information

+ Views can have their own menus and toolbars

+ Items available in menus and toolbars are
available only in that view

+ Menu actions only
apply to the view % Outline 2 2 W\ o Y o0

+ Views can be resized ® main{):int
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Stacked Views

+ Stacked views appear as tabs
+ Selecting a tab brings that view to the

foreground eee

Remote C/C++ - hello/hello.c - Eclipse - /Users/beth/ews/test0917c

nil Includes

Module 3

@ | E I &
L5 Projec &3 18 Remo
S
¥ =5 hello
» [ hello.c

[~ S| | @G | RS O | O § P

N )
vgle e Py ooy

|

= B | [c] hello.c 53 =

- /*

Name : hellolocal.c !
Author |
Version : |
Copyright : Your copyright notice |
Description : Hello World in C, Ansi-style !

#include <stdio.h>
#include <stdlib.h>

int main(void) {

rallel Runt... Remoxe C/C...| »
O || 5% outline 52 =0
RN o % 7

= stdio.h

= swdlib.h

@ main(void) : int

|

|

|

|

|
puts("!!!Hello World!!!"); /* prints !!!Hello World W
return EXIT_SUCCESS;

—————————————— :) >

Console &3 [:_ Problems :*9 Remote Call Hiera Tg Remote Type Hier
C-Build [hello]

gcc -g -0 hello hello.c

Writable Smart Insert 1: | Remote Tools DStore S...c.edu): (100%)

& Remote Environm | = O

& ¢8| B RE G|t B
= E® D hj & % -
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Expand a View

+ Double-click on a view/editor’ s tab to fill the
workbench with its content;

+ Repeat to return to original size

‘ o0 | Efv &I~

& LANCAN AL & Ecrces i | & | @~ a8y [§Y @y @y s [ERcice+ j
02 Q- [ BB S O- |1 i HE 00 Q| @™ Ot |
= — —
' Projec 2% =8|k 9 = O[E= outline % -0 [2  Problergs 83 . V% Tasks | & Console vea
= = Copyright : Your copyright|a 2% S o < 5 = & |
= Description Hello World in lz \ X @ *E i N Jiems =z
ES hello 2] stdio.h L | Description A |Resource Path Lo ™ |
[n)! Includes */ = stdlib.h 1 |
1 @ src @ main(void) : int | |
[¢] hello.c #include <stdio.h> f |
#include <stdlib.h> f
Double int

oz
o=
|
| |
H puts("!!!Hello World!!!1")
click \. = ‘et EXIT_SUCCESS; v
— >
gProblems 23 2 Tasks | & Console v =0
0 items
iption A |Resource Path

+ Window > Reset Perspective

returns everything to original positions
Module 3
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To access help
+ Help Help Contents
+ Help Search
+ Help>Dynamic Help

Help Contents provides
detailed help on different
Eclipse features

browser

Search allows you to
search for help locally, or
using Google or the Eclipse
web site

Dynamic Help shows help
related to the current
context (perspective, view,
etc.)

T~

Module 3

—i'He-lp . Eclié [E=NEERT)
'| Search: ', Scope: All topics
| Contents &~ - B0 o iRl S0
& € Workbench User Guide [q )v) _ \( =
# & Autotools Plug-in User Guide @ a 2 £
# & C/C++ Development User Guide
# & C/C++ Library Documentation Using the help System I

=@ Changelog Editor User Guide

e Eclipse Marketplace User Guide

# € GCov User Guide

© GNU Tools

# < GProf User Guide

# @ Libhover Developer's Guide

He Mylyn Documentation

& < Parallel Tools Platform (PTP) User Guide
# € Photran User's Guide

# € Remote Development Tools User Guide
& € RSE User Guide

@ Usage Data Collector

Browse topics in the Contents frame (@) on the left. Click on a
topic to have it displayed. Use the Back and Forward buttons to
navigate within the history of viewed topics.

m

Searching

To quickly locate topics on a particular subject in the documentation,

enter a query in the Search field. Use the Search frame (‘iih) to
display the Search view. You can narrow the scope of your search
by selecting only the sections you are interested in.

Synchronizing

Clicking the Show in Table of Contents button (%) will select that

topic in the navigation tree. The Link with Contents button (<)
keeps the navigation tree synchronized to the current topic.

Capabilities
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Eclipse Preferences

8.0 7 7 Preferences

Typing ~. .~ ¥+ Eclipse Preferences allow

Save Actions

. f page. i i g
Scalability preference page. The current indentation mode uses tabs

When pasting
[2] Adjust indentation

1 . -
™ Automatically close Custom|zat|0n Of al most
!
M “Strings” .
|
b Build | [2] (Parentheses) and [square] brackets eve ryth I n g
Code Analysis !
b Code Style ! M STl T + TO O pe n u Se
» Debug ! M {Braces}
V Editor .
> Content Assist : Tabulators * MaC .
L‘:\‘/’ei:g : [ﬂh Tal:,l;ey aldjustls indentatioln of th:cu:er: line * Oth e rS :
The tab display value (currently 4) and whether spaces are -
Mark Occurrences ! used to ind'e)ntylines are conﬁg:lred on the code s':yl_e Wl I‘IdOW > Prefe rences...
!
|
!
!
!
!
"/

() Escape text when pasting into a string literal

Automatically indent

Syntax Coloring
A, Language Mapping§ [2] Wrap automatically a I IOW m a n y 0 pti O n S tO be
b New CDT Project Wizard
Task Tags a Ite red
Template Default Values
XL C/C++ Language Option:
ChangelLog
» Help ¥ e 2L b .
e 3 B———— the editor as you type.

+ The C/C++ preferences

XLC/C+ Compler £ tew lines nd braces + In this example you can
adjust what happens in
@ (Gancel ) o)

Module 3 3-11



Preferences

Example

More C/C++ preferences:
+ In this example the

¥ Property Pag
Scripting
Task Tags
Template De
XL C/C++ Cq
XLC/C++ La
¥ Fortran
» Help
¥ Install/Update
P Java
¥ JavaScript
b Parallel Tools
¥ Plug-in Develop
> Remote Systems
» Remote Tools
P Run/Debug
b Server
Service Configu
TAU Configurati
»Team
Validation
»Web
Web Page Editor,
» XML

1900 Preferences
i type filter text Code Style =1 v v
> General
» Ant Configure Project Specific Settings...
VC/C++ Select a profile:
Appearance
» Build [ K&R [built-in] W) ( Edit.. Remove
P Code Style ( New... ) ( Import... )
Rebug
> Editor Preview:
Environment /* M
File Types * A sample source file for the code formMter preview
Indexer = —
Language M eNO Profile 'K&R [built-in]'
»New CDT Pro
Profile name: ' K&R [built-in] Export...

{ Indentation | Braces White Space Control Statements Line Wrapping
General settings Preview: () Show invisible char.
Tab policy: | Tabs only 'y /* N
* Indentation
) Use tabs only for leading indentations *
Indentation size: 4 #include <math.h>
Tab size: 4 class Point {

Indent

] 'public', 'protected', 'private’ within class body

M Declarations relative to 'public’, 'protected’, 'private'
M Statements within function body

M statements within blocks

[ Statements within 'switch' body

M Statements within 'case’ body

M 'break’ statements

) Declarations within ‘namespace’ definition

() Empty lines

public:
Point(double xc, double yc) :
x(xc), y(ye) {

double distance(const Point& other) cong
int compareX(const Point& other) const;
double x;
double y;

b

double Point::distance(const Point& other) ¢
double dx = x - other.x;
double dy = y - other.y;

return sgrt(dx * dx + dy * dy);
}

v
s

int Point::comoareX(const Point& other) con
Y e =) »

Apply ( Cancel ( OK

Code Style preferences
are shown
+ These allow code to be
automatically
formatted in different
ways
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Projects In Eclipse
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Project Types

+ Local

+ Source is located on local machine, builds happen
locally

+ Synchronized

+ Source is local, then synchronized with remote
machine(s)

+ Building and launching happens remotely
(can also happen locally)

+ Remote

+ Source is located on remote machine(s), build and
launch takes place on remote machine(s)

Module 3 3-14



S C/Ce+ - .c-C

“05local - Eclipse SDK

Fle Edit Refactor Navigate Search Project Run LAPIArtifacts MPIArtfacts OpenMP Artifacts Window Help

5 - G N 2
e @8- E-6- [F-0-Q- ik | a® @B OV |8 -G -0e-
EY (0@ c/c++Projects 53  Navigator| — O3 [ [c] Edmiston_Solution... 20\ 1 = B)[8= outiee 3 1 =08
B = . am BR o 7 . RUn
B |7 & incudes ~ I sidoh L hS
= = - aunch Service
= ) Gy >Remote stdib.h
e #- (o vivek's version - U math.h
ta - [} >Edmiston_Solution_2.c 1.5 (ASC & = openmp.h
& £ LAPIsample. ® main
= 55 mpi_op R
# (M Indudes - o
4 19 picop % #pragma omp parallel £
5 MyCProject for (1 =0; i < arraySize; i++ ) -
* E55 MyMPIpiusOpenhp [q
= S >MyOpenMPproject [lexcvs Llexingtod y[4i] = sin( exp( cos( - exp( sin(x[i]) u%
7 B e i De
+ (= Debug
% ) CPile.c 1.1 (ASCH +kv) (
- |6} CFileOrig.c 1.1 (ASCIT +kv) return 0; .
B ratesivec x1 oot 4w | [ |, Debug Service
# |6} exMhpccWorksharing.c 1.1 (ASCL
% |1} exparalleRegion.c 1.1 (ASCII 4k = \
446} exReductionClause.c 1.1 (ASCIT 4 < 5>
) 1] >testOpenMP.c 1.1 (ASCII 4kv) =
+ (&5 PTPSmulation Problems | Console | Propertes | MPI Artifact View | () OpenMP Artifact View 23 |
e Y e e e ) |_| openve artfact | Fiename | tineto. | construct |
3 2 || 6 omo_in_paralel testOpene.c 18 Function Call
1D Hep = 0| (@ #pragma omp paralel for testOpentP.c 2 Opente Pragma -
@ b N i Show pragma region I d .
- Build Service
Al Topics %7 search \_
Related Topics Ll Bookmarks -

viritable Smartinsert | 26:6

File Service

Index Service

8,

Local source

//O,

Search/Index

Navigation

Synchronize

Compute

code

Local

Remote

A

Executable

Source code
copy

Module 3
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Remote Projects

S e - c-C i 05local - Eclipse SDK 2E X
Fle Edit Refactor Navigate Search Project Run LAPIArtifacts MPIArtfacts OpenMP Artifacts Window Help
e @-erE-G -0 Bk [ a®  @W | & 8- -me-

SFraEn6a

[ cfc++Projects 23 Navigator| — O || [c] Edmiston_Solution... 1] testopenMP.c £33

- — * Rllocate memory for the o 5

(= Indudes (double *) malloc( (size_t) (

# (= Debug (double *) lloc( (size_t) (

% Gy >Remote =

%Gy ViveK's version = N

% [ >Edmston_Sobiton_2 15 (asc] ||[B  1F (emR.inpazailel )

£ LAPIsample. RESCE(EOr
= 5 moi_op P

# (M Indudes ' s

#-fe pi.opp 2 omp paralle
5 MyCProject (1=0:1< =
* {5 MyMPIplusOpentp 4
= i5§ >MyOpenMPproject [lexcvs 1.lexingtof ¥[1] = sin( exp( cos( - exp( sin(x[1])

4 (3 Includes |

# (> Debug

%) g} CFile.c 1.1 (ASCII +kv)

- |6} CFileOrig.c 1.1 (ASCIT +kv) return 0;

% {1} exForDirective.c 1.1 (ASCII +kv) )

# |6} exMhpccWorksharing.c 1.1 (ASCL

# |6} exParallelRegion.c 1.1 (ASCII k| -

41} exReductionClause.c 1.1 (ASCII 4 < ~

% [} >testOpentP.c 1.1 (ASCIT %kv) -
(&5 PTPSmulation Problems | Console | Propertes | MPI Artifact View | () OpenMP Artifact View 23 i v=6
&3 RemoteSystemsConnecti

e v ||| __| openve Artifact | Fiename | LineNo | Construct |
] 2| 6 omo_in_paralel testOpeniP.c 13 Function Call
D rep 3 = 0| (@ #pragma omp paralel for testOpentvP.c 2 Opente Pragma

d @l - i Show pragma region
7S
Al Topics %7 search
Related Topics Ll Bookmarks -

viritable Smartinsert | 26:6

Launch ServiceL

Run

)

-

Debug Service

Build Service

File Service

Index Service

Local

pebud

Remote

Compute

A

Executable

Source code

Module 3
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C, C++, and Fortran Projects
Build types
+ Makefile-based
+ Project contains its own makefile (or makefiles) for
building the application
+ Managed

+ Eclipse manages the build process, no makefile
required

Parallel programs can be run on local machine or
on a remote system

+ MPI (or other runtime) needs to be installed

+ An application built locally probably can’t be run on a
remote machine unless their architectures are the same

Module 3 3-17



Checking out the project

Using a Source Code Repository
Introduction to Team Features

Module 3 3-18



Importing a Project from CVS

+ Switch to
Exploring perspective
+ Window > Open Perspective > Other...

+ Select CVS Repository Exploring
+ Select OK P

@CIC+ + (default)

oog
oog

E Remote System Explorer
L[‘_j Resource

Lii: System Monitoring
E0Team Synchronizing

+ Right click in CVS Repositories e
view and select New>Repository
Location... ... e

CVS Repository Exploring - Eclips

QB |E

(1| CVS Repositories &3 o ‘ = ‘ =Y =08

|

New > & Repository Location...

Paste Connection 3V 5
«» Refresh View
Module 3
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Add CVS Repository

8000 Add CVS Repository
Add a new CVS Repository

+ Enter Host: dev.eclipse.org

+ Repository path: cvs|
/cvsroot/tools

Host: dev.eclipse.org

wi

Repository path: >/cvsroot/tools

+ For anonymous access:

User: anonymous|
+ User

&) (&

(1

Password:
+ No password is required :
Connection
+ Connection type: pserver (default) | — )

® Use default port
i n () .
+ For authorized access: O use port
+ User: your userid # Validate connection on finish
+ P . d . d [) Save password (could trigger secure storage login)
asswore: your passwor To manage your password, please see 'Secure Storage'

+ Connection type: Change to extssh Configure connection preferences...

+ Select Finish

(?:I (' Cancel ) ( Finish )

Module 3 3-20



Checking out the Project

CVS Repository Exploring -

XeYe
i o

(]| CVS Repositories £3

|

=N

(= CVSROOT

(= org.aspectj

(= org.eclipse.ajdt

(= org.eclipse.atf

(= org.eclipse.edt

(=>org.eclipse.gef

(= org.eclipse.orbit

(= org.eclipse.pdt

(= org.eclipse.pdtincubator

(= org.eclipse.ptp

> (= core

P (= debug
(=-doc

(= articles

Expand HEAD

Expand org.eclipse.ptp, doc,
and samples

Right click on shallow-mixed
and select Check Out As...

On Check Out As dialog, select
Finish

+ +

(= presentations

(= samples

P (= shallow-c

I #= shallow-mixed
(= tutorials

(= whitepapers

X| .project 1.1

+

8.N.0O
Check Out As

Check Out As

= .
Select the method of check out Cvs 3 project_log.csv 1.3

== » (= old

I b (= photran
h e d efa u |t Of Choose how to check out folder 'shallow' > = rdt
“ \ (® Check out as a project configured using the New Project Wizard P (= releng
C h eC k O u t a S a () Check out as a project in the workspace P = rms
» (= tools

Project Name: shallow X| pom.xml 1.4

(= org.eclipse.tm.core

(= org.eclipse.tm.rse

(= org.eclipse.uml|2.releng
(= org.eclipse.ve

(= org.eclipse.ve-feature
(= org.eclipse.ve.cde

(= org.eclipse.ve.doc

(= org.eclipse.ve.examples

project configured
using the New
Project Wizard” is
what we want

O Check out into an existing project

[ﬂ Checkout subfolders
Working sets

(] Add project to working sets

Working sets: Select

)
w\?/\ < Back (" Next> ) ( cancel

Module 3

=

Expand the repository location —— s iseio:

(= org.eclipse.ptp.doc.isv
(= org.eclipse.ptp.doc.user

New

Check Out

Check Out As... N

iz Tag as Version...
Tag with Existing...

Paste Connection
Compare With...
Compare
Expand All
Add to Branch List...
& Configure Branches and Versions...

«» Refresh View

(> org.eclipse.ve.examples-feature

3-21



New Project Wizard

As project is checked out from CVS, the 800

Select a wizard

Wizard helps you configure the Eclipse information to e
be added to the project e

» (= General

+EXx pan d
[c¥]C++ Project
. [6+] Makefile Project with Existing Code
+Select and click on reos
> lava
+Enter shallow as e
+ Under
expand [ ®NO C Project
- scroll to the bottom C Project —>
* S I t Create C project of selected type [ @ (cancel ) Finish
elecC
+ Select a toolchain that Project name: [shallow
matches your system from = B
Toolcha i ns Location: /Users/beth/ews/test1027-scl1l-tutorial/shallow Browse...
. . . . Choose file system:  default
+ Since we will build/run this on _ _
the remote system, choose Rk o R, - For SC tutorial
H P < Executable (XLF Fortran on Ma MacOSX GCC
. in approPrlatlettOOICh:mk ¥ (= Makefile project MinGW GCC Choose
ou may need to unchec @ Empty Project .
“ y . @ Empty Project - Fortran O Remote XL C/C++ Tool Chain O Re m Ote Ll n U X
ShOW pro_]eCt types a nd ® Demo - Hello World - Fortr ¥ Remote XL UPC Tool Chain GCC TOOl
toolchains only if they are 2 - Solaris GCC I
() Show project types and toolchains only if they are supported on the platform Ch a | n

supported on the platform” |

4+ Click on Finish

MOdUIe 3 (?:' ( <Back ) [ Next> ) ( Cancel ) ( Finish ) . 3_22




C/C++ Perspective

when Prompted

workspace

Switch to the C/C++ Perspective

F Yoo

Open Associated Perspective?

!

(") Remember my decision

This kind of project is associated with the C/C++ perspective. Do you want to
open this perspective now?

e
C No )
No Yes
—

You should now see the shallow projectin your

< C/C++ - I;A PE Developer Edition - /Users/beth/ews/test0930ppedev

800 =
i \ RGN CARE SA - RAE <22 R B Al =1 % [B3CVS Reposit...
O- | v
[ Project Explorer 52 =0 “0|@mBET™ =0
‘ 2R ‘ v‘ -
v & shallow [dev.eclipse.org] An outline is not available.
> (g calec 1.2
s B 12 ™~ E d th
> [R} decs.h 1.2 Xpan e
> [ diag.c 1.2 .
» [ dump.c 1.2 t t
> S metudes pProject roo
> [jinitc 1.2
> [ main.c 1.2 t th
> g time.c 1.2 O see e
> [ tstep.c 1.2 o y
> [} tstep.fo0 1.2 p J t
> [ worker.c 1.2 ro e C S
(3 Makefile.mk 1.2 t t
B_ Problems 23 ~/2 Tasks | El Console | = Propenies‘ &9 Remote Enviro ]
0 items 4
Description A Resource Path
e B >
T =5 shallow = @0 =

Module 3
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Editor Features
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Editors

+ An editor for a resource (e.g. a file) opens when you
double-click on a resource

+ The type of editor depends on the type of the resource
+ .c files are opened with the (e Fremmesmm =0

C/C++ editor by default B TP
+ You can use to METEET—C g
use another editor - :
) dump.c 1. lg) C/C++ Editor '
+ In this case the default Bindudes | Copy sgc ¥ B Remote C/Ce Editor
editor is fine (double-click) Branc 14 Delete B 5 system Editor
L:J:t“es-c l-i Remove from Context Défault Editor
AL'j aclocalimd :AO;IVI’:.EH " \ Other...

AlrTUuADe

+ Some editors do not just edit raw text

+ When an editor opens on a resource, it stays open across
different perspectives

+ An active editor contains menus and toolbars specific to that
editor
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Saving File in Editor

+ When you change a file in the editor,
an asterisk on the editor’ s title bar
indicates unsaved changes

~_

lc] *hello.c 23

+ Save the changes by using
Command/Ctrl-S or

+ Undo last change using Command/Ctrl Z

Module 3 3-26



Editor and Outline View

Double-click on

—

| | C/C++ - shallow/main.c - Eclipse - /Users/greg/Documents /workspace

source file § % e

[ Project Explorer &3

o | G Gy || B

= =

Editor will open in |- s
main view =

> [} copy.c 1.1

Spgocs b 1.2

b [} diag.c 1.1
> 7 dump.c 1.1
> [ Includes

> [} init.c 1.1

> [f)time.c 1.1

> [} tstep.c 1.1

» [ worker.c 1.1
Afjaclocal.m4 1.1

Outline view is

mrconfig.guess 1.1
|5j config.h.in 1.1
|5 config.sub 1.1

shown for file in — =
Coner
Console shows
results of build, e

|y Makefile.am 1.1
|y Makefile.in 1.1
| Gy Makefile.mk 1.1

FrO-Q- Q| @ O~ Y [@3CVS Reposit... HgC/C++
= [ main.c 58 = BE Out &3 (@ Mak =
= - = rdut nniting WW1lJ LGUPWEKOEL.CO. FMLT.0Z fL o= o =
* = Martin Dix (DAR) mrd@koel.co.rmit.oz * lz }X X @ *
* Language = BSD c using Argonne NL macros * = math.h
* 0/8 = Unix System V * 21 mpi.h
* H/W = Encore Multimax 320 * = stdio.h
* * | ]
S ————— o decs.h
++ worker() : void
#include <math.h> ++ setup_res() : MPI_Datatype
#include <mpi.h> @ main(int, char*(])
#include <stdio.h> @ setup_res() : MPI_Datatype
#include "decs.h" @ update_global_ds(MPI_Dat:

extern void worker();
MPI_Datatype * setup_res();

main

int argc;

char * argv[];
{

float pi=4.*(float)atan((double)l.);

float p[n][m]; /* Pressure (or free surface height) */

float uln][m]; /* Zonal wind */

float  v[n][m]; /* Meridional wind */

float psi[n][m]; /* Velocity streamfunction */

float pold[n][m];

float uold[n][m];

float  vold[n][m];

float  h[n][m]; £

float z[n][m]; v
e —————————————— - <>

[L Problems é Tasks E Console &3 ==| Properties &9 Remote Environments

No consoles to display at this time.

local runs, etc. o

—>

[£] /shallow/main.c

Module 3
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Source Code Editors & Markers

A source code editor is @ i linear_function.c 53 =g
special type of editor for D e e

manipulating source |

double evaluate(double x)
code A ,
v add semicolon to end of next line

Language features are ©  doubley =3.0%x +2.0

highlighted /: } ..................................
Marker bars for showing

+ Breakpoints
+ Errors/warnings
+ Task Tags, Bookmarks

Location bar for
navigating to interesting = __

features in the entire file ¢ Task tag
Icons: &  Warning

(X Error
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Code Analysis (Codan)

+ If you see bug icons in the editor marker bar,
they are likely suggestions from Codan

+ Code checkers can flag possible errors, even if
code is technically correct

+ To turn them off, use Preferences ket

X=X47;

' }
Window > Preferences or Mac: Eclipse > Preferences E—

C/C++ > Code AnaIVS|s —

.. Problems 23 2| Tasks | El Console | = Pro|
a nd u nCheCk 800 1 error, 2 warnings, 0 others
? Code Analysis = v v Description
d I I p ro b I ems General a @ Errors (1 item)
C/C++ Problems A B W _ @ items)
A Name Severity = ammg.s : A . o, \
* Select O K to Potential Programming Problems ui, Possible assignment in condition 'x=1
™ ignment in conditi % Warni .1, Possible assignment in condition 'x=1'
Close l;j S m h, o effec 5 W, g
@ Cl al method and nol & Warnin ]
Preferences & ) Catching by reference is recommended & Warning
[21 Sugg d p. thesi d exp %y Warning
H . ™ | No return value € Erro
+T0 remove i1cons. ™ Unused return value @ Erro
1 [21 rrrrrrrr 5 War
nghtmouse on - e ; & var
[T4) Suspicious semicolon & Warnin; g
Project > Run C/C++ Z i
7\ :

t Wiza
roperty Pages Setting . .
Task Tags an ent to |‘tse
Template Default Valu 3 ; P v
. X1 C/C++ Comniler T e e e e >
Code Analysis - \
®@ Uncheck all C_concel ) (@ 3-29




Line Numbers

+ Text editors can show line numbers in the 1?*

left column 3 Name
4 Author

5 Version
6 Copyrigl

: 7 Descrip™ =&
+ To turn on line m g ooP=O
. g *x/

numbering: | e R —

. . . > Name : hellolocal.c 19
+ nght-mOUSe CI'Ck N Author : 11 #?nclude
the editor marker bar Toggle Breakpoint b notict }f#md"de
] Enable Breakpoint in C, Ansi-style
+ Click on Breakpoint Types P s

Numbers Add Bookmark...

Add Task...
v Show Quick Diff ~0Q

Show Line Numbers ); /* prints !11Hello World

Folding

Preferences...
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Navigating to Other Files

* On demand hyperllnk Elnrain.cfs [h]decs.h E}init.c
+ In main.c line 135: ‘

1
1
13¢
131 /*
+ HOld down Command/ctrl key 1 initialise data structures and construct packets to be sent to workers

133 */

e.g. on call to initialise 134

135 initialise(p, u, v, psi, pold, uold, vold, di, dj, z);

13¢ diag(l, 9\ p, u, v, h, z);

1

1

1

+ Click on initialise to navigate
to its definition in the header file
(Exact key combination
depends on your OS) B mane  [Wdeeeh  (hBRSE

. 26 #include <
+ E.g. Command/Ctrl and click on 27 binctude

H 14=1 H 29void initialise(p, u, v, psi, pold, uold, vold, di, dj, z)
Inltlallse 30 float p[n][m];

31 float u[n][m];

32 float v[n][m];

+ Open declaration ! Float yeitoatan

+ Right-click and select Open e
- . */ v
Declaration will also open the |_Open Declaration _________F3

for (i = 1;\1 < proc_cnt; i+4) {
for (7 A9Q; j < n; j++) {

#include <st Open Type Hierarchy F4

file in which the element is finclude <=3 Open Call Hierarchy A
) Quick Outline #0

declared int main(vol  (ick Type Hierarchy BT

puts("!! ! irld!!
Explore Macro Expansion #=

+ E.g. in main.c line 29 right-click } " oagle Source/Header . ~Tab
on decs.h and select Open S
Declaration Note: may need to left-click
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Content Assist & Templates

+ Type an incomplete function name e.g. get into the editor,
and hit ctrl-space

+ Select desired completion value with cursor or mouse

13
14 int main(void) {

15 puts("!!!Hello World!!!" /* prints !!!Hello World!!! */

16 get
l . s yClLlldl_UIlIULl\ vUId) L L A
18 ret @ getdelim( ** _lineptr,* _n,int __delimit
19 } @ getenvitonst char * __name) : char * O
20 @ getline(char * * __lineptr,* __n,FILE * _ strear

o netlnadavaldnuhle *  lnadawvn int . nelam)

< ————— : a

Press '~Space’ to show Template Propos

Hit ctrl-space again

+ Code Templates: type for code templates

‘for’ and Ctrl-space

17 for
18 [=| for - for loop for (int var = @; var < max; ++var) {
19 ret = for - for loop with temporary variable |

20} }
21

More info on code templates later
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Inactive code

+ Inactive code will appear grayed out in the
CDT editor

260 #define VAL
261 #ifdef VAL

262 acopy_one_to_two(VAL, ds, res.indx);
263 #else
264 acopy_one_to_two(res.row, ds, res.indx);

265 #endif

260 //#défine VAL
261 #ifdef VAL

262 acopy_one_to_two(VAL, ds, res.indx);
263 #else
264 acopy_one_to_two(res.row, ds, res.indx);

265 #endif
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Team Features
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“Team” Features

+ Eclipse supports integration with multiple
version control systems (VCS)
+ CVS, SVN, Git, and others

+ Collectively known as “Team” services
+ Many features are common across VCS

+ Compare/merge
+ History

+ Check-in/check-out
+ Some differences

+ Version numbers
+ Branching
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CVS Features

[} main.c 1.3
> (g timeg 1.2

+ Shows version numbers next to L
each resource R

+ Marks resources that have S

» [K) decs.h 1.3
= . o

changed

+ Can also change color (preference & @, ... -

~~~~~~~~~~ d;j++) {
el  Build Selected File(s) 1) % n

option) EECT SN 5chronize with Repositor
s Compare With T —
AD|  Replace With > Update
#% Run C/C++ Code Analysis Create Patch... ip]
+ Context menu for Team | ¢
Properties 38l i

I i Tag as Version
operations
jmak  Llean Selected File(s) start;j<=jend;J++) {
Mak B Id Selected File(s) ?J‘l)f‘,";

0 1 <my 1+4){

+ Compare to latest, another

Replac Wth b AnotherBra ch or Version...  B[J

branch, or history s T e

Properties

+ Synchronize whole project (or any
selected resources)
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File Modification

2&void calcuvzh(jstart,jend,p,u,v,cu,cv,h,z, fsdx, fsdy)

(11 144 291int jstart,jend;
+ Open “calc.c
31 float ul[n][m];
32 float v[n][m];

H 33 float cul[n][m];

+ Add comment at line 40 | R
35 float h[n][m];
36 float z[n][m];

+ Save file Iloat fsdx, fsdy;

39 int  i,3,ip,dp;
19 /*

+ File Wi” be marked to Ei :;:j:::t:imjit]::;ej++){
indicate that is has been

} ip = (3+1) % n;
5 for (1 = 9; 1 < m; i+4){

1
/|
4 ip = (i+41) % m;
Wl 4 cul310ip] = 0.5%Cp[3I10ipl+p 301D *ul3Iip];
m Od |f| ed 1 evlipl[i] = @.5*Cpljp][11+p[FI[iID*vlip][il;
19 z[jpllip] = (fsdx*(v[jpl[ipl-v[ipI[i1)-fsdy*(uljpllip]
50 -ul310ipd))/Cp L3 0i]+p (30 0ipd+pLip] [ipd+p[ip] [10D;
51 h[310i] = p[31011+40.25*CuliI0ipd*ul3Iipd+ul3I0i]*ul3I01]
52 : +v[jp][(1I*v[p][(1J+v[3I[1I*v[3I[10);
v 13* Cc
”k‘j:':—shal [cvs.ncsa.uiuc.edu) 14% "A
b [g >calec 1.1 15 * by
b [ copy.c 1.1 16 *
> [h) decs.h 1.3 11: Pr
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View Changes

Right-click on calc.c and
select Compare
With>Latest from HEAD

Compare editor will open
showing differences

between local (changed)
file and the original

Buttons allow changes to
be merged from right to
left

Can also navigate between
changes using buttons

Module 3

[€ cale.c &0 calc.c R
el ¢ Compare

v [® Translation Unit

+® calcuvzh
e calcuvzh
€0 cu
e v
€0 fsdx
@D fsdy
g, ¢ Compare Viewer ¥ & (<] ol | Ah N 4L
Local File 1.1 ® |Remote File 1.1
32 float v[n][m]; 30 float p[n][m];
33 float cul[n][m]; 31 float u[n][m];
34 float cv[n][m]; 32 float v[n][m];
35 float h[n][m]; 33 float culn][m];
36 float z[n][m]; 34 float cv[n][m];
37 float fsdx, fsdy; 35 float h[n][m];
38 { 36 float z[n][m];
39 int 1,3,ip,Jp; 37 float fsdx, fsdy;
10 /* 38 {
11 * Added a comment here 39 int i,3,1ip,Jp;
12 | */ \,[;,,
for(j=jstart;j<=jend;j++) { 11 for(j=jstart;j<=jend;j++) {
ip = (3+41) % n; 42 ip = (G+1) % n;
for (1 = 9; 1 <m; i44){ 43 for (i = 0; 1 < m; i+4){
ip = (i41) % m; 1 ip = (i41) % m;
cu[j1[ip] = 0.5*Cp[31[ipl+p (3101 ID*u310 45 cul310ip] = 0.5*(p[jI[ipd+p[FI[11D*u
cvl[jpl[i] = 0.5%Cp[ip][1]+p[3I1[i1D*v]p] 16 ev[ip][i] = 0.5*Cp[ip][11+p[3I1[1]D*v
z[jpl[ip] = (fsdx*(v[jpl[ip]-v[ipI[i])-f: 47 z[jpllip] = (Fsdx*(v[jpl[ipl-v[jip][i]
L 2L AN 2 2 Y s AQ PR i Bt B T W N e B ot PPN ol B ataR N RPN o
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Revert To The Latest Version

+ Right-click on the “shallow” project and select
Replace With>Latest from HEAD

+ Review the resources that will be replaced,
then click OK

®eNo Overwrite Uncommitted Changes

The selected elements contain uncommitted changes that will be overwritt
Should the replace proceed?

[\
(?)
&/

( cancel ) ( <<Denils ) € ok )
b

The following elements contain uncommitted changes that will be overwritten.

Changes

=T
=5 shallow

[E® calc.c
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MPI Features
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MPI-Specific Features

+ PTP’s Parallel Language Development Tools (PLDT) has
several features specifically for developing MPI code

+ Show MPI Artifacts

+ Code completion

+ Context Sensitive Help for MPI
+ Hover Help

+ MPI Templates in the editor

+ MPI Barrier Analysis
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+ In Project Explorer, select a project, folder, or a

single source file
+ The analysis will be run on the selected resources

‘ S e | e Ct 000 C/C++ - shallow/mail =TMdeg - /Users/beth/ews/testptp ]

ArtifaCts Lz‘j v’(,ill OZvEJjEU' C‘A;'G';'JJ‘B' '_ﬁ'O'Q;v " E_‘H;ﬁCVSReposit... »
1 S _B%[¢ ¥ =0|[ min - . (ovan-o
+ Run the analysis by e T G b Show Opent Avtifatts | Ly o

¥z >shallow [cvs.ncsa.uiuc.edu)

> i includes int tid; ! W4 MPI Barrier Analysis vh

Cl iCki n g O n d rO p = » [ cale.c 1.1 MPI_Datatype * » Show UPC Artifacts )h:

» [ copy.c 1.1 MPI_Init(&argc, |

» [Hdecs.h 1.2 i . ,' :
3 Wrim-szn i Show LAPI Artifacts o0 v

down menu next to * B 1

» [} dump.c 1.1 if  proc_cnt <23 T Tain(int, char*(])

the analysis button L { o oo

fprintf(stderr, "must have at least 2 processes,

v

» [ftime.c 1.1 LT
i i » MPI_FinalizeQ);
> qutstep,c 1.1 return 1;
» [ worker.c 1.1 } ' =
|5} aclocal.m4 1.1
|- AUTHORS 1.1 if ( (n % (proc_ent - 1)) 1=0 )
|5 Changelog 1.1 { .
5 comile 1.1 P > T | — >
| config.guess 1.1 = > = =
[5 config.hiin 1.1 [2/ Problems »/BTasks‘E Console | ] PropeniesJ* MPI Artifact View £3 i X3pvyea
5} conﬁg.sub 11 Artifact Filename LineNo ‘
LDconngure 11 B MPLInit main.c 67 “
orks on local an U 5
-
. 15§ COPYING 1.1 » MPI_Comm_rank main.c 69
r t fl I s j depcomp 1.1 P MPI_Finalize main.c 74
e m O e e kD?NSTALL A,l. # MPI_Finalize main.c 83 .
[ install-sh 1.1 _ |9 MmPi_Barrier main.c 89 X
|5 Makefile.am 1.1 MIEY 3 e} =

a [alome
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Markers indicate the
I O C a ti O n Of a rti fa C& 000 C/C++ - shallow/main.c - Eclipse - /Users/beth/ews/testptp
editor 0| @ a6 @ 8- |4 B [%:0- 8 G |O- 4|8 | @5 - 55 Bacvs Repesi.. =

Th MPI A t-f t v- ec ¥ = 0|([g mainc 8 =0 Ezozé @m|ET|=0
e r I a c Iew S Hel A float vold_start[m]; 2 2@ e e =
5 >s int proc_cnt; p _ P RN *
1 0 int tid; Iy | mafh,h
I IStS th e t e a n d P MPI_Datatype * res_type; = mpi.h
R Pl stdio.h
H = = [ ] MPI_Init(&argc, &argv); m =1 decs.h
location of each artifact | :: B B S e, e .
1B » MPI_Comm_rank(MPI_COMM_WORLD, &tid); £+ setup_res0 : MPI_Datatype
I"J B N — N -
> L'Ji t. 1 if ( proc_cnt < 2 ) @ main(int, char*(])

® setup_res() : MPI_Datatype
fprintf(stderr, "must have at least 2 processes, © update_global_ds(MPI_Dat:
» MPI_Finalize(Q);
return 1;
}

Navigate to source code| : ==

||ne by dOUbIe'C“Ck'ng\ ijgﬁfﬁ:‘;il
on the artifact

Run the analysis on

if ( (n % (proc_ent - 1)) 1= 0 )

!

!

|

!

!

|

!

!

|

!

!

|

!

|

| Artifact Filename
n ain.c
U

e iné

. - |5 configure 1.1 MPI_Init m & <

another file (or entire S eomreac 1 2 R " G A
g COPYING 1.1 ’ MPI_Comm_rank main. 69
: I H - Jdepcomp‘l ! » MPI_Finalize main.c 74
project!) and its e e - 2
Eginstall-sh 1.1 . » MPI_Barrier m 89

Makefile.am 1.1

markers will be added |- e i
to the view

Click on column
headings to sort

Remove markers via x
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MPI Editor Features

| [c] *main.c 83 .

=ox owg + Code completion will show all

float vold_start[m];
int proc_cnt;

int tid;

MPI_Datatype * res_type;
MPI_Init(&argc, &argv);

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);
MPI_Comm_rank(MPI_COMM_WORLD, &tid);

>

0

B R the possible MPI keyword

o) completions
B sudioh + Enter the start of a keyword

e then press <ctrl-space>

++ setup_res() : MPI

s werp €=
(+]

MPI_Barrier(MPI_Comm ) int 4 |Blocks each task until all tasks have called it.

if (| e MPI_Bcast(void*, int, MPI_Datatype, int, MPI_
{ ® MPI_Bsend(void*, int, MPI_Datatype, int, int,
f MPI_Bsend_init(void*, int, MPI_Datatype, int,i
MPI_Buffer_attach( void*, int) int
MPI_Buffer_detach( void*, int *) int
MPI_Barrier(MPI_Comm comm) : int
MPI_Bcast(void * buffer,int count,MPI_Dataty
MPI_Bsend(void * buf,int count,MPI_Datatype |
MPI Bsend_initfvoid * buf.int count.MPI Datz ©

) »

A

‘o o0 000

Press '~ " to show Template Propos A

@ main(int, char*(]

B ———

float vold_start[m];

4+ Hover over MPI
API

+ Displays the
function prototype
and a description
Module 3

>

int proc_cnt;
int tid;
MPI_Datatype * res_type;

MPI_Init(&argc, &argv);
MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt); m
MPI_Comm_rarge(MPI_COMM_WORLD, &tid);

Name: MPI_Comm_rank

Prototype: int MPI_Comm_rank(MPI_Comm, int *)

Description:

Returns the rank of the local task in the group associated with a communicator.!" |

Press 'F2" for focus

return 1;

}
if ( (n ¥ (proc_cnt - 1)) 1= 9 )
{

if ( tid == 9 )
fprintf(stderr, "(number of processes - 1) must be a mu-
v

= } ) >
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Context Sensitive Help

Click mouse, then press help
key when the cursor is within a
function name

+ Windows: F1 key

+ Linux: ctrl-F1 key

+ MacOS X: Help key or

Help» Dynamic Help

A help view appears (Related
Topics) which shows
additional information
(You may need to click on MPI
API in editor again, to
populate)
Click on the function name to
see more information

Move the help view within your
Eclipse workbench, if you like,
by dragging its title tab

Module 3

=4

MPI Comm r@nk(MPI COMM WORLD, &my rank

ot PN el b o R v o P o) o e

lName: MPI_Comm_rank

Protoype: int MPI_Comm_rank(MPI_Comm, int *)
Description:
Returns the rank of the local task in the group associated with a comi

|

i Help 52 & s =g

Related Topics
v About

Click below to see help.

Some special
info has been
added for MPI

See also:

[ Editor view click hers
B int MPI_Comm_ranE\;MPI_Comm, int *)

APIs
1? Help £3 B S el \-b {Parallel D
Contents ’. Search Related Topics C.w Bookmarks [ Index
A
~
MPI_Comm_rank

NAME

MPI_Comm_rank — Determines the rank of the
calling process in the communicator.
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MPI Templates

+Allows quick entry of common patterns in MPI programming

+ Example:
MPI send-receive
+ Enter:
mpisr <ctrl-space>
+ Expands to a send-receive

—

MPI_Comm_rank(MPI_COMM_WORLD, &rank);
MPI_Comm_size(MPI_COMM_WORLD, &p);
if (rank == @){ //master task
brintf("Hello From process @: Num processes: %d\n",p);
for (source = 1; source < p; source++) {
MPI_Recv(essage] 100, MPI_CHAR, source, tag,
MPI_COMM_WORLD, &status);
printf("%s\n" ,message);
}

pattern
+ Highlighted variable names
can all be changed at once
+ Type mpi <ctrl-space> <ctrl-
space> to see all templates

mpi
—| mpiif - MPI_Init and Finalize

/* | [ mpisr - MPI Send Receive
unT

Module 3

“eb' }
else{ // worker tasks
/* create message */
sprintf(message, "Hello from process %d!", my_rank);
dest = 9;
/* use strlen+l so that '\@' get transmitted */
MPI_Send(message, strlen(message)+1l, MPI_CHAR,
dest, tag, MPI_COMM_WORLD);

Add more templates using Eclipse preferences!
C/C++>Editor>Templates
Extend to other common patterns
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MPI Barrier AnaIyS|s

= C/C++ - MyBarrier/src/MyBarrier.c - Eclipse SDK - C:\ews\runtime-cdt40

File Edit Refactor Source Statistics Navigate Search Project Run Window Help

G- ei- [ @~

7 010
i
X — =

L Project Explorer &2 = 8|/ [¢] matrixio.c €] zzzzTemplateTest.c ;f;éj MyBarrier.c &2 14

-0 S

| @/t |

Ly Resource

0-

= O || 5= outline 2 (@) Make Targets| = &

— ‘ B|¥ if (my_rank !=0){ AR laz }\, \S e v
< B * create message -
= MyB ™ stdio.h
g .y armer sprintf (message, "Greetings from process %d! o s s ,IO
#- [ Includes dest = 0: = string.h
=3 src L e e ] = mpih
€ is8e strlien+l SO that get transmitte
+-git| MyBarrier. ® B : void
i A%ﬁb Lol oCe MPI_Send (message, strlen (message) 1, MPI_CHr - a‘i”?r? ;mxn)._ t
i ID":c = ,“gt dest, tag, MPI COMM WORLD) ; mamint, cnar =Ll :
- | - 2
A /] MPI Barries (MPI_COMM WORLD): a
+-f3= MySampleProject ' As——— - -
else{ =
printf ("From process 0: Num processes: %d\n'
for (source = 1; source < p; source++) {
MPI_Recv(message, 100, MPI_CHAR, source,
MPI_COMM WORLD, &status); =
printf ("$s\n",message); E
}
MPI_Barrier (MPI_COMM WORLD) ;
= = Barrier():
/7, MP1 Barriers &7 g 3 ¢ v
i < >
Function |2 Problems | v Tasks | E] Console |7 Barrier Matches 5% = O || ¥4 Barrier Errors 2 i ¥ =0
P A —
';7 man i Barrier Matching Set Function
fi main -4
YA main Barrier Matching Set | Function Filename LineNo ~ [#) 711 Error Lo
P N N N +- U path 1 (1 barrier(s))
Y main =W Barrier 1(2) Barrier MyBarrier.c 8 WA Path 2 (0 barri
¥ main /) Barrier 1 Barrier MyBarrier.c 8 " e gihi2(0hami= () 5
W8 | Barrier /4 Barrier 3 MyBarrier.c 41 ’Ir,r‘or x - ber of barri =
I+
=" Barrier 2 (1) main MyBarrier.c 31 Loop (dynamic number of barriers)
/i Barrier 2 main MyBarrier.c 31
=" Barrier 3 (2) main MyBarrier.c 41
4 Barrier 1 Barrier MyBarrier.c 8
" Barrier 3 main MyBarrier.c 41
"4 Barrier 4 (0) main MyBarrier.c 57
+- U Barrier 5 (1) main MyBarrier.c 62 v
<] v |23 > <] >
¢ a| Q=

Module 3

Local
files only

Verify barrier
synchronization in C/
MPI programs

Interprocedural static
analysis outputs:

+For verified programs,
lists barrier statements
that synchronize
together (match)

+ For synchronization
errors, reports counter
example that illustrates
and explains the error
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MPI Barrier Analysis — Try it

Run the Analysis:

. .| Proje T
+ In the Project i —
EXplOrer, SeIeCt the "sllow [cvs.ncsa.uluc.edu]
project (or directory, B
or file) to analyze > [ decs.h 13

» ) diag.c 1.1

+ Select the MPI A
Barrier AnalySIS ¥ Show MPI Artifacts
action in the pu“- © ¥ Show OpenMP Artifacts

down menu
# Show UPC Artifacts
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MPI Barrier Analysis — Try It (2)

+ No Barrier Errors are found (no pop-up
indicating error); Two barriers are found

8 Eclipse File Edit Source Refactor Navigate Search Project Run Window Help

®SNOO lc| C/C++ - shallow/main.c - Eclipse - /Users/beth/ews/
Ci~ @& @ a6 |/ S 502 Q | ®S & EN O] 85
[ Project Explorer &2 = 0| [c] main.c 23
8 & ‘ - MPI_Finalize();
c —= 84 return 1;
Vlizshallow [cvs.ncsa.uiuc.edu] 85 }
> [q) cale.c 1.1 6
I Eﬂcopy.c 1.1 if (tid !'= @) {
» [K} decs.h 1.3 worker();
» [} diag.c 1.1 # 29 MPI_Barrien(MPI_COMM_WORLD);
> Eﬁj dump.c 1.1 99 MPI_Finalize();
g 91 } else {
[pY Includes 02
> E‘ﬁinit.c 1.2 93 /* master process */
> [g) main.c 1.4 94
J= .q'JJtime.c 1.2 nr T T . P S - an.
> [ tstep.c 1.1 : -
» [¢) worker.c 1.2 #7) MPI Barrier Matches |7 MPI Barriers 23
Af aclocal.m4 1.1 Function Filename LineNo IndexNo
) AUTHORS 1.1 /i main main.c 89 1
iy Changelog 1.1 7 main main.c 206 2

|5y compile 1.1
\-j config.guess 1.1
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MPI Barrier Analysis - views

/) MPI Barriers 52 = B |/[2. Problems | v| Tasks | &l Console | % Barrier Matches &2 = O || Barrier Errors &2 i ¥ =0
i© i v Barrier Matching Set Function

Function Barrier Matching Set | Function Filename LineNo ||| = "4 Error » main
YI main =)W Barrier 1(2)  Barrier MyBarrier.c 8 &880 Path 1(1 barr?er(s))
Wh main /i Barrier 1 Barrier MyBarrier.c 8 ") Path 2 (0 barrier(s)

i ) =" Error main
7  main 7 Barrier 3 main MyBarrier.c 41 = . ) .
YA main =Y Barrier 2 (1) main MyBarrier.c 31 +- 4 Loop (dynamic number of barriers)
" main /i Barrier 2 main MyBarrier.c 31
4 Barrier =1 Barrier 3 (2) main MyBarrier.c 41
/i Barrier 1 Barrier MyBarrier.c 8

/i Barrier 3 main MyBarrier.c 41
i Barrier 4 (0) main MyBarrier.c 57

+ '/‘I.l Barrier 5 (1) main 7 MyBarrier.c 62 v
< | > <] > < | >
o \ alome
/ N\
MPI Barriers view Barrier Matches view Barrier Errors view

Groups barriers that

match together in a If there are errors, a
Like MPI Artifacts view, parrier set — all counter-example

double-click to navigate processes must go shows paths with
to source code line (all  through a barrier in the ~ MiSMatched number
3 views) set to prevent a of barriers

deadlock

Simply lists the barriers
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Barrier Errors

+ Let’ s cause a barrier mismatch error
+ Open worker.c in the editor by double-clicking
on it in Project Explorer

+ At about line 125,

prv = worker[PREV];

@ MPI_Buffer_attach( void*, int) int
@ MPI_Buffer_detach( void*, int *) int

129
121 nxt = worker[NEXT];
. . 1 jstart = worker[JSTART];
enter a ba rrler. 1 jend = worker[JEND];
124
£125  MPL.B|
+ Ty pe M PI B 126 /* © MPI_Barrier(MPI_Comm ) int Blocks each task until .
— 127 recel g MPI_Bcast{void*, int, MPI_Datatype, int, MPI_|
. L28 %/ o MPI_Bsend(void*, int, MPI_Datatype, int, int,
+ H It Ctl = S pa Ce 1“\ - ® MPI_Bsend_init{void*, int, MPI_Datatype, int,
131
132

+ Select MPI_Barrier

+ Add communicator
arg MPI_COMM_WORLD and closing semicolon

ththth TR v e v oy

25 MPI_Barrier(MPI_COMM_WORLD);

(e

= =
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Barrier Errors (2)

+ Save the file

+ Ctl-S (Mac Command-S) or File > Save
+ Tab should lose asterisk indicating file saved

E] *worker.c 23 |:> @ yyquer.c 23

+ Run barrier analysis on shallow project again

+ Select shallow %
project in Project PR SEA XL
Explorer first ¥ Show MPI Artifacts

\‘ # Show OpenMP Artifacts

/// MPI Barrier Analysis N
#» Show UPC Artifacts
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Barrier Errors (3)

.00 MPI Barrier Analysis
|

* Ba rrier‘ Er‘ror iS found ' Found barrier synchronization error(s)!
+ Hit OK to dismiss dialog |

+ Code diverges on line 87
+ One path has 2 barriers, other has 1

"#7) MPI Barrier Matches | #Zi MPI Barriers |"//) MPI Barrier Errors &3 . 5. Pr Double-click
, on a row in
Barrier Matching Set Function Filename imeNo IndexNo B . E

VUi Error main main.c @ arrier crrors

TWiPath 1 (2 barrier(s)) 0 view to find
/iBarrier 1 main main.c 89 the Iine |t

0
0
1
fliRarric worker worker.c 125 3 .
o o references in
#7iBarrier main main.c 206 2 the code
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Fix Barrier Error

+ Fix the Barrier Error =™ e

#7104 MPI_Barrier(MPI_COMM_WORLD);

before continuing
+ DOUbIe_C“Ck On the '/7i MP! Barrier Matches |7 MPI Barriers |"#Z\MPI Barrier Errors 52

Barrier Matching Set Function Filname LineNo IndexNo

barrier in worker.C | e
- . #/iBarrier 1 main
tO qUICkly naVIQate /// Barrier 3 worker

B
. VIiPath 2 (1 barrier(s)) 0 0
to It f7iBarrier 2 main main.c 206 2
+ Remove the line and save the file
_Or_

Right mouse on worker.c in Project Explorer
and do Replace With > Latest from HEAD

Team »

Compare With [ 2

Replace With > Latest from HEAD

% Run C/C++ Code Analysis Another Branch or Version...

| History...
Module 3 Properties £ Previous from Local History 3-54




Remove Barrier Markers

+ Run Barrier Analysis again to remove the error
- and/or -

+ Remove the Barrier Markers via the “X” in one
of the MPI Barrier views

//) MPI Barrier Errors &3 i =0

Barrier Matching Set Function Filename LineNo
#liError main main.c 87

Module 3 3-55



Synchronizing the Project
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Synchronizing the Project

+ Because we will be running on a remote
system, we must also build on that system

+ Source files must be available to build

+ We will use a synchronized project to do this

+ Only needs to be done once for each project
+ A synchronized project could have been created
initially

+ Files are synchronized automatically when
they are saved

+ A full synchronize is also performed prior to a
build
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Converting To Synchronized

+ Select File>New>Other...
+ Open the Remote folder A -

+ SeleCt Convert C/C++ or Szl::::t:ri:jae::toautomaticallysynchronize project resources _
Fortran Project to a — =
Synchronized Project

. » (= General nT«
+ Click Next> Lo
» (= CVS
P (= Fortran
P (= Java
¥ (= Remote
[ Convert C/C++ or Fortran Project to a Synchronized Project

[c=]Convert to a Remote Project
&, Remote C/C++ Project

[cfl Synchronized C/C++ Project
[—E;;Synchronized Fortran Project &

P (= Remote System Explorer
P (= Tasks
P (= XL UPC
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+

Convert Projects Wiza rd

Select checkbox next to shallow

For Connection:, click on New...
Enter as directed:
+ Target name
+ Host name of remote system
+ Userid and Password

Click Finish to close it
Back in the Convert Projects

Enter a directory name in the
Location field; select Browse...
+ Sample: /u/ac/trainXX/shallow

+ Project files will be copied under this
directory

Click Finish

Module 3

Convert Projects

Convert to a synchronized project

Converts a managed or unmanaged project to a synchronized
project by adding a sync nature

Candidates for conversion:

[Z‘ =Fshallow

Synchronization Provider: | Git v
Remote Provider: | Remote Tools v

Connection: forge %) (New..)

/

- \
{_ Browse... )

Location: fujac/trainXX/shallow

(?\) (" <Back ) (" cancel ) € Finish k\
- = P R
0No Target Environment Configuratiol

Generic Remote Host

Properties for connecting to a generic host

Target name: forge
Host Information

O Localhost @ Remote host

Host:  forge.ncsa.illinois.edu

User:  trainXX

@ Password based authentication

Password:  esssescsses

() Public key based authentication

File with private key:

Passphrase:
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Synchronized Project

+ Back in the Project
Explorer, decorator on
project icon indicates
synchronized project

+ Double-+ icon

» == project

hallow |dev.eclip
+ Before sync » [ calc.c 1.2
|v1:§s_hauow [dev.eclipse.org) I E‘BCODY.C 1.2

+ After sync

¥ 5 shallow [dev.eclipse.org]
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Set Active Build Configuration

+ The Active build configuration determines which system will
be used for both synchronizing and building

+ Right-click on the project and select Build
Configurations>Set Active>Remote (Build on remote

aChIne) Close Unrelated Projects SRUSH
Build Configurations > Set Active ) v 1 Default
Make Targets > Manage... 2 Remote (Build on emote machine)
Index > p
Synchronization »  BuildAll
Clean All [
\(/f!\'g‘a.tf Damnta Corcta dis ol | Build Selected... \E Properties &9 Remote Environments Eﬂ History

+ The project should synchronize immediately

Remote Synchronization: (46%)
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Building the Project
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Building the Project

+ Select the project in Project Explorer, click on the «.
hammer button to run the build
> C/C++ - shallow/calc.c - Eclipse - /Users/

L[| Project Explorer &3 =4 B ] & 62 &+ 6 50 R Qe | ® S - -
— v V*Ll Lv v

A <

- ({5 Project Explorer 23 = 8 [d calc.c 2
e d = shallow [dev.eclipse.org) [EEESMEESE i)

> [} calc.c 1.2
» |} copy.c 1.2

+ By default, the Build Configuration assumes there is a
Makefile (or makefile) for the project
+ In this case, there is no Makefile,

SO the b U I Id WI I I fa I I . I:_ Problems «: Task =) Properties E@ Remote Environ
CDT Build Console [shallo™

See Console: S
+ We || see hOW to Change it |f the bU||d **x¥ Build of configuration Remote for project shallow ****
command is different from make all
make: *** No rule to make target “all'. Stop.

‘make -f Makefile’

*¥¥x¥ Build Finished ****
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Editing Project Properties

+ The build command is specified in the project properties

+ Open the properties by right-clicking on shallow and selecting
Properties (bottom of the context menu list)

+ Click on C/C++ Build

+ Uncheck Use default build command

+ Enter make -f Makefile.mk in the Build Command field

+ Click OK to close N O Properties for shallow
project properties type filter text C/C++ Build (o
dialog Resource 1

g‘;i(':ieissu“d Configuration: | Remote [ Active )

Build Variables
Discovery Options
Environment
Logging

Settings
Synchronize

Tool Chain Editor " Builder type: External builder

XL C/C++ Compiler I

[ =] Build

Builder

C/C++ General "] Use default build command

Cvs
Discovery Options Build command: make -f Makefile.mk I

Environment
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Re-Building the Project

+ Click on the «- button again to run the build
+ Build output will be shown in the Console view

[E;_ Problems s/: Tasks E Console &3 = Properties El@ Remote Environments @1 History
CDT Build Console [shallow]
main.c:97: error: syntax error before ':' token

main.c:97: error: syntax error before ')' token
main.c: At top level:

main.c:212: error: syntax error before "return"
make: *** [main.o] Error 1

% Build Finished *¥*

+ Exact output depends on your compiler
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Build Problems

000 | | C/C++ - shallow/main.c - Eclipse - /Users/greg/Documents /workspace @)
i~ oo | @~ &S [ @~ v | 0 [ B £y Bgc/c++ [Resource £0Team Synchr... £3Parallel Debug »
O- SRR = =R
Py Project Explorer &3 = 0| [4 cale.c el main.c &2 =0 SE Out &3 @ Mak =08
[:;\_§V| 4 if (tid 1= @) { BV o %Y
- - e - - worker();
+ Build prOblemS will be Vi shallow {cvs.ncsa.uiuc.edu] MPT_Bar i er(MP1_COMM_HORLD); & math.n
> [fcalec 1.1 )0 MPI_Finalize(); = mpi.h
h H H t f > [ copy.c 1.1 )1 } else { 2 stdio.h
S OWn In a Va rle y O » [R decs.h 1.3 32 2 decs.h
b [} diag.c 1.1 3 /* master process */ ++ worker() - void
> [} dump.c 1.1 4 i ++ setup_res() : MPI_Datatype
Wa ys » i) Includes ::~ chunk_size = n / (proc_cnt - 1); & mainint, char*(])
> [}initc 1.2 § @ setup_res() : MPI_Datatype
® update_global_ds(MPI_Dat:

/* calculate each worker's boundary */
master_packet[JSTART] = (i - 1) * chunk_size;

+ Marker on file —> » i maine 14
Marker on editor line e 11
Line is highlighted

er.c 1.2
|Afj aclocal.m4 1.1

+ 4+ 4+ +

. Gy AUTHORS 1.1 master_packet[JEND] = 1 * chunk_size - 1
— ] 105
Marker on overview ruler T 105 e
. . |53 config.guess 1.1 107 prv = proc_cnt-1;
Listed in the Problems [ config in 1.1 108 else ’
= |5j config.sub 1.1 109 prv = i-1;
view |53 configure 1.1 110
a7 configure.ac 1.1 Hl master_packet[PREV] = prv; -
COPYING 1.1 113 if (i == proc_cnt - 1)
114 nxt = 1;
115 else
116 nxt = 141;
117
118 master_packet [NEXT] = nxt; L
DyMakeflemk 11N, | - — ] <> — <f»>
. . . =0 zg;;"g 1‘ ! \ Tasks | & Console | ©= Properties | 5 Remote Environments | [/ History ve=ag
+ Double-click on line in Brews 1 .
A Resource Path Location Type
-
Problems view to go e ot Imaine —Jshaow - line 57 [C/Cos Probleml |
- - @ syntax error before )’ token main.c /shallow line 97 C/C++ Problem
to I O Ca tl O n Of e rro r I n @ syntax error before "return" main.c /shallow line 212 C/C++ Problem
n) syntax error before "' token =
a
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+ +

Fix Build Problems

Fix errors by changing ‘:" to °;” on line 97

Save the fi Ie lh| decs.h L] copy.c E] diag.c m main.c 52 ] worker.c B =8
. . . 93 /* master process */ A

RebUIId by preSSIng bUIId '\1 chunk_size = n / (proc_cnt - 1);

bUtton ‘ Q‘ for (1 = 1; 1 < proc_cnt; i+4) { O

/* calculate each worker's boundary */

Error marke rS have been l” master_packet[JSTART] = (i - 1) * chunk_size;

101 if (i == proc_cnt - 1)

removed 192 master_packet[JEND] = n - 1;

103 else
104 master_packet[JEND] = 1 * chunk_size - 1; v

Check console for correct | < e==———— e .— . i
build output 2 Problems | 7 Tasks |l RN

CDT Build Console [shallow]

**¥¥ Build of configuration Remote for project shallow ****

make -f Makefile.mk all

mpicc -g -c -0 main.o main.d
mpicc -g -c -0 time.o time.c
mpif99 -g -c -o tstep.o tstep.f90
mpicc -g -c -0 worker.o worker.c
mpicc -g -c -0 dump.o dump.c

mpicc -g -o shallow calc.o copy.o diag.o init.o main.o time.o tstep.o worker.o dun

*¥¥¥x Build Finished ****
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Forcing a Rebuild

+ If no changes have been made, 21 poblems 'é'T[ashks” 'Ellconsoue SN
make doesn’t think a build is needed .

\make: Nothing to be done for “all’.

+ In Project Explorer, Rightmouse on
project, select
Clean Project Build Project

Clean Project N

& Refresh F5
Close Project

Close Unrelated Projects

+ See CO n SO I e \ [:_ Problems J_f, Tasks .E Console 53

CDT Build Console [shallow]

*¥¥* (lean-only build of configurat

+ Then rebUild | Q‘ make -f Makefile.mk clean

rm -f shallow calc.o copy.o diag.o
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Running the Program

Resource Managers
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Running the Program

+ Creating a resource manager

+ Starting the resource manager

+ Creating a run configuration

+ Running (launching) the application
+ Viewing the application run

Much of the following setup is

@ configuration that you only need to

do once: This icon will remind you.

Do this
once
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Resource Managers

+ PTP uses the term “resource manager” to refer to

any subsystem that controls the resources required
for launching a parallel job.

+ Examples:

+ Batch scheduler (e.g. LoadLeveler, PBS, SLURM)

+ Interactive execution (e.g. Open MPI, MPICH?Z2,
etc.)

+ Each resource manager controls one target system
+ Resource Managers can be local or remote
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Monitoring/Runtime Perspectives

+ Parallel Runtime Perspective
+ Used for legacy PTP Resource Managers
+ System Monitoring Perspective

+ Used for newer Configurable Resource Managers (since
PTP 5.0)

+ Which one is used?

Resource Manager System Monitoring Parallel Runtime
IBM LoadLeveler v

IBM Parallel Env 4
MPICH2 v

Open MPI 4
PBS-Batch-Generic 4

PBS-Batch-Interactive 4

Remote Launch 4

SLURM v
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Preparing to Launch

+ Setting up a resource manager is done in the System Monitoring
perspective
+ (For PTP 5.0, this applies to PBS)

+ Select Window>0pen Perspective>Other...
+ Choose System Monitoring and click OK \

‘ WWLEEVE Help
B C/C++ (defaul) New Window
[z CVS Repositony] Exploring
ﬁDebug
%Foman Open Perspective \| %> Debug
85 Java Show View > \&” Team Synchronizing
©JJava Browsing
‘fgjjava Type Hierarfhy : :
5% parallel Deb Customize Perspective... Other...
arallel Debug .
822 parallel Runtime Save Perspective As...
(1) Planning Reset Perspective
i Remote C/C++ Close Perspective
E Remote System Efplorer - )
B Resource L Close All Perspectives
&" Team Synchronizing Navigation >
X XML
~ Working Sets >
Preferences...

( Cancel ) ( OK \)
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System Monitoring Perspective

+ System view

ing - fool/x.c - Eclipse SDK

.
1
|“

WMWWIIIIMIIWWW@
A ARRADIA R AU
10
IIIIIIIIIIIImmM

+ Jobs running
on system

W 40216.. sl lincoln 86400 2011 4 RUNNING
[0 40216.. crs1 lincoln 86400 2011-... 201 4 RUNNING
. . B 40216.. sl lincoln 86400 2011-... 2011 UNNING
* oln 86400 2011-... 2011 4 TG
C I Ve J O S 40216... crs1 ncoln 86400 2011-... 2011 4 RUNNIN
[ 40216.. sl lincoln 86400 2011-... 2011 4 RUNNING
[ 40216.. sl lincoln 86400 2011-... 2011 4 RUNNING
W 40216.. sl lincoln 86400 2011-... 2011 I

|

= g

838 Inactive Jobs 8
. - step owner  queue wall queuedat dispatchc totalcore: status
n a Ct I Ve O S O 40217.. crsl lincoln 86400 2011-... ? 4 SUBMITTED
— 40217... sl lincoln 86400 2011-... ? 1 SUBMITTED
linggln 86400 2011-... ? I |
O 40217... crsl BMI

UBMITTED
011 ? 1 SUBMITTED
011-... ? 1 SUBMITTED
86400 2011, ? 1 SUBMITTED
40217.. crsl lincoln | 86400 2011-... ? 1 SUBMITTED
sl lincoln 86400 2011 ? 1 SUBMITTED
li 86400 2011-... ? 2 SUBMITTED s
lincol ? 2 SUBMITTED v
le ies | 1% le -y =0
es to di is ti
(% <
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About PTP Icons

- - - | A ’,\\ E
+ Open using legend icon in o legen
t I b Resource Manager Icons
Ooolbar (@ STARTING
() STARTED
; (@ STOPPING
NeNe Parallel Runtime -\Qﬁllowl | —
— ™~ — o= 1, »  SUSPENDED
JF_J' U‘LO_W‘%'O'Q?'Q'J;::A& @ ERROR
Machine Icons Node Icons
&= Up L 2. UNKNOWN
&= DOWN [ DowN || PROCESS RUNNING
= Ed ERROR PROCESS TERMINATED
@

82 ERROR
2 UNKNOWN
Job Icons Process Icons
) STARTING « STARTING
2 RUNNING - RUNNING
() SUSPENDED y  SUSPENDED
© COMPLETED < COMPLETED
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= System Monitoring - Eclipse 1

|Fi|e Edit Navigate Search Project Run Window Help
i FrR Qo O & v

Pii
]

+ Right-click in Resource LI
Managers view and = ) sy Do this
select Add Resource ~——— "o L onee
Manager 0

= Stop Resource Manager

888 Active Jobs &2
|| Add Resource Manager...

Remove Resource Manager

Edit Resource Manager

Set Default Resource Manager

+ Choose Resource 8o
Manager Type: oo et e e
edu.illinois.ncsa.forge

.pbs.batch.openmpi

Resource Manager Types:

IBM LoadLeveler

IBM Parallel Environment

MPICH2

Open MPI

Open MPI-Generic-Interactive
PBS-Generic-Batch
PBS-Generic-Interactive

Remote Launch

SLURM
edu.illinois.ncsa.forge.pbs.batch.mvapich2
edu.utk.nics.keeneland.pbs.batch
edu.utk.nics.kraken.pbs.batch

+ Select Next>

2
—

< Back ( Next > ) (" cCancel Finish

/
\
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Configure Control Connection

+ Choose Remote Tools for Remote service provider @
+ Choose the remote connection you made previously

Do this
+ Click Next> onee
eNO

Control Connection configurati

Enter connection information

Remote service provider: | Remote Tools

B
Connection name: forge _¢] ( New... )
» Advanced Options
(?:l ( <Back ) € Next> k) ( cancel ) Finish

Module 3 3-77



Configure Monitor Connection

+ Keep default Monitor Connection (same as Control Connection),
click Next

8OO

Do this
Monitor Connection configuration once

Enter connection information

@Sam as control t

Remote service provid Local

Connec tion name: Local Nev
Advanced Opt

(?:I ( < Back \'( Next> ) ( Cancel ) ( Finish )
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Common Configuration

+ Keep default name
4+ Can automatically start Resource Manager (leave unselected

today)

4+ Click Finish @

8.0

Common Resource Manager Configuration Do this
once

Change any settings for the resource manager

Name and description

[ﬂ Use default name and description:

Name: PBS-Generic-Batch

Description: XML Configurable Resource Manager

Startup

") Automatically start resource manager when Eclipse starts

- | —————

(’?:x ( < Back ) Next > [ Cancel ) C Finish k)
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+ Right click on new pa— I —
resource manager and alcetaats -
select Start resource

(r) PBS-Generic-Batc

Start Resource Manager

mManager O St@p Resource Manager

+ If everything is ok, Add Resource Manager...
you should see the Remove Resource Manager
resource manager change EdityResounce;Managex =

‘EE Active Jobs 53 §

Hass

Set Default Resource Manager =

to green

+ If something goes™{ong,
it will change
to red

(*> PBS-Generic-Batch (LML_JAXB) (¥ PBS-Generic-Batch (LML_JAXB)
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System Monitoring

forge.ncsa.illinois.edu

S . . h 1800 | | System Monitoring - shallow/Makefile.mk - Eclipse - /Users/beth/ews/test1027-sc11-tutorial ()
yste m VI eW / W I t I~ ﬁ"m-ﬂ* 8202 |5 4 v 5 =Re=1 B [y 22 System Moni... (& CVS Reposit... g)C/C++ 888 Parallel Runt...
|

abstraction of nodes e TS

for selected Resource =\ elect Resource Manaabk [T
Manager | :

; S5 Active Jobs 83 = Inactive Jobs =0
| step owner queue wall queued dispatc| totalcores status

3716.fsched alberto normal 43200 201... 2011... 18 RUNNING
3718.fsched dsouth normal 14400 201... 2011... 6 RUNNING

" = = = 3719.fsched dsouth normal 14400 201... 2011... 4 RUNNING
Actlve a n d I n a Ctlve O bS 3720.fsched alberto normal 43200 201... 2011... 18 RUNNING
3722.fsched  dhguo normal 12600 201... 2011.. NN S—————— 1 =——————%

3723.fsched cheatham normal 43200 201... 2011.. 16 RUNNING
3724.fsched cheatham  normal 43200 201... 2011.. 16 RUNNING
3725.fsched cheatham  normal 43200 201... 2011... 16 RUNNING
3726.fsched cheatham  normal 43200 201... 2011.. 16 RUNNING | (E AT
3727.fsched cheatham normal 43200 201 2011 16 RUNNING

Hover Over nOde In S - RUNNING

. . (| 3720 tsched hesham normal| 43200 301 o011, 16| nuANING

System VIeW to See JOb || @ 3731fsched cheatham normal 43200 201... 2011.. 16 RUNNING | |[SETETR T T] T T e I e e e e e

running on node in == —————— T I

- . | Console £3 L Properties | ;. Problems | v=| Tasks =
Active Jobs view

EDOEEODOOEO

1 i M & = &
|| CDT Build Console [shallow] &€ ¢ =(| LB B8 G 4 B v
|

|| **** Build of configuration Remote for project shallow ****
|

make -f Makefile.mk all
||mpicc -g -c -0 calc.o calc.c

mpicc -g -C -0 COpy.0 COpy.C .

il

Hold mouse button
down on a job in Active One node with
Jobs view to see where 16 cores
it is running in System
view
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Running the Program

(Launching a Job)
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Create a Run Configuration

i = Run Configurations -9 .. .. &J
O Y ‘_g;v %V Ov Create, manage. and run configurations N
\ Create a configuration to launch a parallel application in Parallel Perspective (@)
! Bun As > I ( B - 3 v Configure launch settings from this dialog:
Vpe filter text | 7 - Press the 'New' button to create a configuration of the selected type.
[c] C/C++ Application = - Press the 'Duplicate’ button to copy the selected configuration.

Orgamze Fa!ontes"' [F] Fortran Local Applical

@ Launch Group
&=} Parallel Application

x

- Press the 'Delete’ button to remove the selected configuration.

Y

- Press the 'Filter' button to configure filtering options.

+ Open the run configuration

’ - Edit or view an existing configuration by selecting it.

dialog Run /

Co nfi g u rati o n S - / Configure launch perspective settings from the Perspectives preference page.
+ Select Parallel Application
+ Select the New button

Or, just double-click on ‘ ;

Parallel ApplicatiOn Filter matched 4 of 4 items

to create a new one @ [ R [ close
Depending on which flavor of Eclipse you I_Vc;te:hwe SOTheti?')es
installed, you might have more choices in interchange the terms

. . “‘Run Configuration” and
Application types “Launch Configuration”
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Complete the Resources Tab

Enter a name for this run
configuration, e.g.
“shallow-pbs-batch”

In Resources tab, select
the PBS resource manager
you just created

&

Do this
once

.00

Run Configurations

Create, manage, and run configurations

IEES

Create a configuration to launch a parallel application

Name: _<hallow-pbs-batch

type filter text
E} C/C++ Application
@Foman Local Application
Java Applet

-1 Resources

Resource Manager:

) Application | ()= Arguments ETEEnvironment Synchronize | =] Common

edu.illinois.ncsa.forge.pbs.batch.openmpi ?]

s RPN cation

(edu.illinois.ncsa.forge....)
Select the destination

@ Launch Group
8-} Parallel Application
§=% shallow

Name

Job Name:

Account:

queue - debug

The MPI Command field
allows this job to be run
as an MPI job

—) Queue:

Number of nodes:

Total Memory Needed:

Wallclock Time:

) MPI Command:

+ Choose mpirun
Enter the resources

needed to run this job

+ Use 1 nodes, 4 cores (MPI
tasks)

Module 3

Filter matched 7 of 7 items

@)

&/

MPI Number of Cores:

Export Environment:

[ Basic PBS Settings

A
Advanced PBS Settings Import PBS Script | ~

Value

'Pm_JOb

debug v
: ©

00:05:00

mpirun v

e
™

" The name assigned to the job by the gsub or qalter commg|

Description

Account to which to charge this job.

Designation of the queue to which to submit the job.

Number and/or type of nodes to be reserved for exclusive

- ~/
Maximum amount of memory used by all concurrent proce
Maximum amount of real time during which the job can be

Which mpi command to use.

the '-np' value

All variables in the gsub command'’s environment are to be

View Script

( View Configuration

( Restore Defaults

<€

Apply (" Revert )

Close

:(Run)i
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Complete the Application Tab =

Do this
once
Select the Application FYors e
ta b Create, manage, and run configurations ,,4—»,\‘.
Ch Oose th e Ap pl ication Create a configuration to launch a parallel application (‘/j

program by clicking the TEIEES O rrerers
Browse button and pe iter tox 3
locating the executable on e rorm o ootcag || Zoretet Profec®

(9= Arguments | I Environment | Synchronize | = Common

. shallow (" Browse )
the remote machine Ja doet - | I
ava pplication Application program:
4" Use the Same ShaHOW g%::‘llji:::::alion fuf/ac/tibbitts /shallow/shallow (" Browse )
executable 4 shallow

[T) Copy executable from local filesystem

Select Display output Path to the local file:

from all processes in a
Co n So I e v i ew play output from all processes in a console view

i : « TS ) - p Y ()
CIICk Run tO SmeIt the Filter matched 7 of 7 items : Apply AN R

application to the job & P
scheduler
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Job Monitoring

‘@NO

|_| System Monitoring - shallow/Makefile.mk - Eclipse - /Users/beth/ews/test10

Job initially appears in
“Inactive Jobs”, then in

“Active Jobs”, then returns to| .

Inactive on completion

This short-running program
may not run long enough to
appear in “Active Jobs”

Status refreshes
automatically every 60 sec
Or force refresh with menu

After status = COMPLETED,
Can view output or error by
right clicking on job, selecting
appropriate output

Module 3

|.u’|‘o - O- Q|2

Resource Managers &3

o
v ¥S (o

(p= ,;,T' v

(#) PBS-Generic-Batch (LML_JAXB)

step

=0

wall queuedz dispal A |totalcore: status

| [0 3626.fsched g

opal debug

[0 3627.fsched gopal debug

600 2011... ?
600 2011... ?

? SUBMITTED
? SUBMITTED

debug | 27 2 | lsusmreo

&5 i

... System Mo

=8 iiii system: forge.ncsa.illinois.edu 23

22 Active Jobs

step

E: Inactive Jobs 23
owner queue
[0 3626.fsched gopal debug

[ 3627.fsched gopal debug
[0 3736.fsched tibbitts debug

=0

wall queued:z dispa' A totalcore: status

L
|

600 2011... ? ? SUBMITTED
600 2011... ? ? SUBMITTED |||
?2? ? T
\ Resume Job
Q) Cancel Job
Hold Job

Release Job

Suspend Job

21 Get Job Error
21 Get Job Output

> Refresh Job Status

¥ Remove Job Entry
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Job Output

_ — =
G S =g
+ Afte r Statu S = CO M P LETE D step owner queue  wall queuedate dispatc total¢ status |:
! [0 3626.fsched  gopal debug 600 2011-1... ? ? SUBMITTED
1 [ 3627.fsched gopal debug 600 2011-1... ? ? SUBMITTED
Ca n VIeW OUtpLIt or error by O 3769.fsched alberto normal 43... 2011-1... ? 18 SUBMITTED |:
. . . - . [ 3774.fsched dsouth normal 14... 2011-1... ? 12 SUBMITTED
rlght CI |Ck|ng on JOb, Selectlng O 3772.fsched tibbitts 22 ? ? COMPLETED
. [0 3773.fsched tibbitts debug 772 ? ? COMPLETED
| W [3777.fsched [tibbits  [debug [ ?]?  ou ———]
d p p ro p Fl ate ou tp Ut [0 3783.fsched tibbitts debug ?77? Resume Job
2 = O Cancel Job
& Console 2 ) £ p | 2. problems | ¥ Tasks| Hold Job
. . onsole roperties | ;.. Problems | v Tasks
Rel b
+ Output/Error info shows in C:j- eTFoo 603777 R
Suspend Job
1 Potential energy 6.505 Kinetic Enery
ConSOIe VIeW Total Energy 48032.016 Pot. Enstropl & Get Job Error
Cycle number 950 Model time in days 0.9 3 Get Job OUtPUt
Potential energy 760.460 Kinetic Enery
Total Energy 48385.996 Pot. Enstropl o Refresh Job Status
Cycle number 1000 Model time in days 1.8 3 Remove Job Entry
Potential energy 21561.933 Kinetic Energ o
Total Energy 48000.496 Pot. Enstrophy 1.805456e-27 m E
- ‘E
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+ If projects build prior
to launch, you can

+ Go into

Building before Run &

Do this
once
To bring up Preferences dialog,
use Window>Preferences or
Mac: Eclipse>Preferences
. | ®NO ' _Preferences
tu rn It Off' \ type filter text Launching =1 v
General A
C/C++ -~ Save required dirty editors before launching A
’ Changelog ‘ () Always () Never ® Prompt ‘ﬂ

Preferences>Run/ i
Debug and click on java

Fortran
Install/Update

Library Hover

Launching. Parbel Toals

Remote Systems

+ Uncheck "Build (if Sopipaoiiony

required) before

Console

- ” '.
Ia u n Ch I n g String Substitution

View Management
View Performance
Service Configurations

+ Should be set by o

default now

Module 3

=/

v

Wait for ongoing build to complete before launching

@ Always () Never () Prompt

Launch in debug mode when workspace contains breakpoints

() Always ) Never () Prompt

Continue launch if project contains errors ‘J

() Always ) Prompt

Ceneral Options

<’ Build (if required) before launching >

lﬂ Remove terminated launches when a new launch is created

[2] Prompt for confirmation when removing a configuration from th

« : >

Cancel ) ( oK )
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Exercise

+ Start with your ‘shallow’ project

+ Create and start Resource Manager
+ Build; Run shallow

+ See results

+ Change something
+ Change m and n in decs.h

+ Rebuild and re-run

Module 3 3-89



Advanced Features

Searching
Fortran
Refactoring

Module 3 .



Searching
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Switching Perspectives

arch  Project Run m Help

C/C++  New Window

+ Switch to C/C++ Perspective;
one of three ways:

1. Choose the Window>Open
Perspective menu option
Then choose Other...

upper right corner of
screen (hover over it to

Click on the Open Perspective button in the

|Eclipse SDK

G- - |38 New Editor
IR Open Perspective

Show View

e | Customize Perspective...
sthor Save Perspective As... }
ol Reset Perspective...
”fi; Close Perspective
_. Close All Perspectives

*l on<> =z *
2 momE D

Navigation
#includeT=starorhs
#include <stdlib.h>

Open Perspective

- CVS Repository Exploring -
%> Debug

£ PTP Debug

88 PTP Runtime

[ Resource

int main(void) {

£Y Team Synchronizing

see names)

Click on a perspective
shortcut button

Module 3
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OK ] \ Cancel
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Find/Replace within Editor

+ Simple Find within editor buffer
+ Ctrl-F (Mac: Command-F)

. ® T O Find/Replace ([9) diag.c =

39 */
Find: | pmean| 2 ;,v‘{
E] 41 float ptot,ketot,etot,enstot,ptime,pmean;
42 int lstlszp;
43

Replace with:

Direction SCOps 44 ptot=0.; ketot-0.; etot-@.; enstot = @.; pmean - 9.;
® Forward ® Al 45 for (3 = @; J < n; J++d {
46 i=0; i ;1
() Backward () selected lines 4‘.‘ "°;m§;n -eém;a::;’[jﬂg;{
Options j } ¥
[] Case sensitive [ZIWrap search 5;) pmean = pmean/(m*n);
") Whole word [7) Incremental 51_ fo'j G —’0; i< 3o
52 ip = (3+1) % n;
") Regular expressions 53 for (1 = @; 1 < m; i44){
54 ip = (i41) % m;
P — 55 ketot += p[jI[11*@.25*Cu[j1[ip]*ul3]1[ip]+ul3]1[1]*ul3][1]
( Find ) (_Replace/Find ) 56 +v[ipl[(1I*v[ipl[(11+v[3I[1I*v[3I[11D;
57 ptot += (p[j]1[i]-pmeand*(p[jI[i]-pmean);
C Replace ) C Replace All ) 58 etot += h[jJ[i];
59 enstot 4= z[jpl[ipl*z[jpl[ip] * 0.25*
C Close ) 60 (p[310J+p[310ip]+p[Gp][ip]+p[dp1[11D;
—a 61 }

W
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Mark Occurrences

(C/C++ Only)

+ Double-click on a variable in the CDT editor

+ All occurrences in the source file are
highlighted to make locating the variable
easier

+ Alt-shift-O to turn off (Mac: Alt-Cmd-0O)

.c| diag.c £3
AR *
11 float ptot,ketot,etot,enstot,ptime,pmean;

12 int 1,3,1ip,Jp;

14 ptot=0.; ketot}@.; etot=0.; enstot = @.; pmean = 9.;
5 for (3 = 0; J < n; j+s+) {
{ for (1 = 0; 1 < m; 144) {
pmean = pmean+p[j][i];
)}
50  pmean = pmean/(m*n);
51 for (3 = 0; J < n; Jj++){
ip = (J+1) % n;
for (1 = @; 1 < m; i144){
ip = (141) % m;
55 ketot += p[j1[1]*@.25*Cu[j][ip]*ul3][ipJ+ul3][1]*u[3]1[1]
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Language-Based Searching

(C/C++ and Fortran)
(Search] Project Window + 4 E.g., search for every call

+ “Knows” what things can

be declared in each o= = to a function whose name
language (functions, e R starts with “get”
variables, classes, o3l _
modules, etc.) el + Search can be project- or
! - 4 Fortran...\ .
, workspace-wide

- Search

=5 File Search £ C/C++ Search | E5 Fortran Search | 7 Java Search I %7 Plug-in Search‘ = Search
Search string (* = any string, ? = any character): =
get* < [F] Case sensitive =5 File Search I 557 C/C++ Sear?l F§” Fortran Search I Java Search I %7 Plug-in Searchl
Search pattern:
Search For Limit To X
[T Class / Struct Function [ Vvariable [] Declarations [] Definitions get” v [IRegular expression
[} Union Method [T Field References [ All Occurrences (* = any string, ? = any character)
[7] Enumeration ["]Enumerator [ Namespace Search for Limit to
[C] Typedef [ Macro [7] Any Element ["] Commeon block Function () All occurrences
Subroutine ["IModule () Declarations
Scope [ variable [ Program @ References
© Workspace () Selected resources () Enclosing projects
() Working set: Scope
@ Workspace () Selected resources () Enclosing projects
() Working set:

@ ]
(
= @ | Search I[ Cancel ]

L
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Find References

(C/C++ and Fortran)

+ Finds all of the places where a variable,
function, etc., is used

+ Right-click on an identifier in the editor

+ Click References»
or References»

References > Workspace (3G
Search Text I Project

Working Set...
Make Targets

. =
.c| main.c 23 ]
0o MFL_vatutype ™ res_type,

+ Search view
. ‘ MPI_Init(&c_:rgc, &argv); .
shows matches T T Commrank(UPLCOM_IORLD, £eicd; TR 0

= 71 if  proc_ent < 2 )|

fprintf(stderr, "must have at least 2 processes, no t %d\n",

proc_cnt);
4 MPI_Finalize();
e ——— J
El consdfe [;_ Problems &a emote Environments »;;" Search &3 =0
n < > | o Dy = 7
J,Llr‘x"&‘& ;—:“:, =]
References to 'proc_cnt' (11 matches)
v =% shallow
v [gm (11 matches)
© main, line 68: MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt)
|

@ mal ne 73: fprintf(stderr, "must have at least 2 processes, not %d\n", proc_cnt);
/ @ main, line 78: if ((n % (proc_ent - 1)) !=0) 3 96
MOdU e 3 @ main, line 95: chunk_size = n / (proc_cnt - 1); =




+

Open Declaration

(C/C++ and Fortran)

Jumps to the declaration of (i mane s

a variable, function, etc., 134
i er s . . 135 initialise(p, u, v, psi, pold, uold, vold, di, dj, z);
even if it’' s in a different 5 diagCt, 8., by v Vi, 2;
f||e 13 for (i = 1; i < proc_cnt Undo
13¢ for (e . Revert File
B
Left-click to select identifier | .i; e Open Declaration
. . . . 144 acopy_two_to_oneyf Open Type Hierarchy F4
nght‘C“Ck on identifier 145 MPITS/‘end(&_u‘__‘s.EG' Open Call Hierarchy AXH

RPN oYl

Click Open Declaration Goes to its declaration

in copy.c

++ : - »
C/C Only . l.¢) main.c .| copy.c &3
Can also Ctrl-click s :

. 59 copy(src[column], dest[column], sizeof(src[column]));

(Mac: Cmd-click) on an 60}
. . ‘% . 11 bl
identifier to hypel‘“nk to 62 acopy_two_to_onef twodim,onedim,column)
its declaration 63float  twodimln]lm];

64 float  onedim[m];
651int column;
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Search - Try It!

1. Find every call to in Shallow.

2. In worker.c, on line 42, there is a declaration
float pln] [m].

a) Whatism (local? global? function parameter?)
b) Where is m defined?

c) How many times is m used in the project?

3. Find every function whose name contains the
word time
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Fortran Specifics
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Project Properties

+ Right-click Project
+ Select Properties...

L™ Project Ex?r &3 28 Remote Systems
i_c >shalloW [dev.eclipse.org]

[f) cale.c 1.2

Lf} copy.c 1.2

+ Project properties are settings

that can be changed for each
project

+ Contrast with
workspace preferences,
which are the same

| e NoO Properties for shallow
type filter text Resource (=1 v v ‘ reg a rd I eSS Of W h at
siiers EERNTE N project is being edited
C/C++ General Location: JUsers/beth/ews/test1027-scl 1-tutorial /shallow + e g e d ito r CO I O rS
[ ] [ ] ’

Ccvs

Discovery Options
Environment

Paths and Symbols
Project References
Run/Debug Settings
Service Configurations
Settings

Last modified: October 31, 2011 3:49:23 PM

Text file encoding

® Inherited from container (MacRoman)
(O other: MacRoman ¥

("] Store the encoding of derived resources separately

+ Set in Window »
Preferences
(on Mac, Eclipse»
U Preferences)

T + Careful! Dialog is

bl New text file line delimiter
Task Tags
Tool Chain Editor ® Inherited from container
Validation . A
Variables () Other:
WikiText
<€ B
C?) ( cancel ) € oK h]

very similar

Module 3
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Converting to a Fortran Project

+ Are there categories labeled Fortran General
and Fortran Build in the project properties?

e NO Props
type filter text Resource

[ " Resource |
Builders Path:
C/C++ Build Type:

No Fortran categories ———— | "C/Cx+ Cenenal Location:

Project References T e .
Remote Development Do this

Remote Paths and Symbc Text file el once
Run/Debug Settings @ Inherit
Service Configurations

+ If not, the project is not a Fortran Project
+ Switch to the Fortran Perspective

+ In the Project Explorer view, right-click on the
project, and click Convert to Fortran Project

+ Don’ t worry; it’ s still a C/C++ project, too ¥ =5 >shallow

+ Every Fortran project is also a C/C++ Project
Module 3 3-101
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Project Location

+ How to tell where a project

resides?
| ®NO Properties for shallow
" type filter text " Resource =2
+ In the project properties W oath enaliow
dialog, select the b C/C++ Build Type;

b C/C++ General ione = — 3
Resou rce Category s C t::atnon. JUsers/beth/ews /test1027-scll-tutoria)'sha
tm - - iy

Discovery Options

Environment Text file encoding
Paths and Symbols ® Inherited from container (MacRoman)
Project References
Run/Debug Settings O Other: MacRoman ~
Service Configurations
. 9 : [ Store the encoding of derived resources separately
Settings
> Task Repository New text file line delimiter
Task Tags
Tool Chain Editor ® Inherited from container
»Validation "
Variables O Other: -
WikiText
 — J
® ( Cancel ) ( Ok
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Error Parsers

+ Are compiler errors not appearing in the @
Problems view? Do this

once
+ Make sure the correct error parser is enabled

+ In the project properties, navigate to
C++ Build »Settings or Fortran Build »Settings

+ Switch to the Error Parsers tab
+ Check the error parser(s) for your compiler(s)

|19 Binary Parsers m

775 CDT GNU Make Error Parser 6.0 (Deprecated)
v/ <=Photran Error Parser for GNU Fortran (gfortran)
v/ ©=CDT GNU C/C++ Error Parser
v/ =CDT GNU Linker Error Parser
v =CDT GNU Assembler Error Parser
V| <= Photran Error Parser for Absoft Fortran
v =Photran Error Parser for Intel Fortran 8.1
v/ o= Photran Error Parser for Lahey/Fujitsu Fortran 7.1
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Fortran Source Form Settings

+ Fortran files are either free form or fixed form;
some Fortran files are preprocessed (#define, #ifdef, etc.)

+ Source form determined by filename extension
+ Defaults are similar to most Fortran compilers:

Fixed form: .f fix for fpp ftn £77

Free form: .fO8 .fO3 .fo5 .fo0

< unpreprocessed
.FO8 .FO3 .F95 .F90

< preprocessed

+ Many features will not work if filename extensions
are associated with the wrong source form
(outline view, content assist, search, refactorings, etc.)
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Fortran Source Form Settings

Do this
once
) e OO0 Properties for shallow
+ In the prOJeCt type filter text Source Form 15 e
properties, select > Resource —
Builders Source form/filename associations:
Fo rt ran Ge nera I > :gg*’ 2uild | File Name/Extension Source Form
++ Genera
S cvs *F Fixed Form - INCLUDE lines ignored v
o u rce Fo rm » Fortran Build * FO3 Free Form - C Preprocessed v
VFortran General
Analysis/Refactoring *.FO8 Free Form - C Preprocessed v
+ Se | eCt source fO Fm Paths and Symbols ~F77 Fixed Form - INCLUDE lines ignored -
] | Source Form |
fo r ea C h fl I e n a m e Project References *.F90 Free Form - C Preprocessed v
. $unk/£1>_ebug Settings * F95 Free Form - C Preprocessed v
ask Tags
eXte n S I O n > Validation *.FIX Fixed Form - INCLUDE lines ignored v
*FOR Fixed Form - INCLUDE lines ignored >
+ CI |Ck o K * FPP Fixed Form - INCLUDE lines ignored -
*FTN Fixed Form - INCLUDE lines ignored v
*f Fixed Form - INCLUDE lines ignored v
*.fo3 Free Form v
*.fo8 Free Form v
A Fixed Form - INCLUDE lines ignored v
(’?) | Cancel | [ OK ]
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Enabling Fortran Advanced Features

+ Some Fortran features are by default @
+ Must be explicitly enabled Do this

+ In the project properties dialog,
select Fortran General » Analysis/Refactoring
+ Click Enable

i} 8 OO Properties for shallow
Ana IySI S/ type filter text Analysis/Refactoring
>R
Refa Ctorl ng Bj;zz:ze To enable Open Declaration, Find All Reference
»C/C++ Build view, content assist, and refactoring in Fortran
+ ClOSE a n d re-O pen »C/C++ General following box. A program database (index) wil

. CVs a Fortran file is or saved.
d ny FO rt ran ed |t0 'S » Fortran Build @nable Fonr:ﬁ@

. VFortran General - -
+ Th |S tu rn s O n th e (¥ Enable Fortran Declaration view

Paths and Symbols @ Enable Fortran content assist (Ctrl+Space)

i P h Otra n I n d exe r” Sourca Form @ Enable Fortran Hover tips

Project References

4+ Turn it off if it' s slow @

s/ G
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Project Properties — Try It!

1. Convert shallow to a Fortran project

2. Make sure errors from the GNU Fortran
compiler will be recognized

3. Make sure *.f90 files are treated as
“Free Form” which is unpreprocessed

4. Make sure search and refactoring will work in
Fortran
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Advanced Editing

Code Templates
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Code Templates

(C/C++ and Fortran)

+ Auto-complete common code patterns
+ For loops/do loops, if constructs, etc.
+ Also MPI code templates

+ Included with content assist proposals
(when Ctrl-Space is pressed)

+ E.g., after the last line in tstep.f90, type “sub” and
press Ctrl-Space

+ Press Enter to insert the template

lh| decs.h .c] init.c [F] *tstep.fo0 23

el il i ) ICIRICI BRI, RPN BRI PRI

......

&7 end subroutine

29  sub
Module 3 99 subroutine...end subroutine - Subroutine (lower case)
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(C/C++ and Fortran)

+ After pressing enter to insert the code
template, completion fields are highlighted

Lh| decs.h .c] init.c F] *tstep.fo0 3

29~ subroutine Fama parameters)

1%

91 | end subroutine name

+ Press Tab to move between completion fields

+ Changing one instance of a field changes all
occurrences
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Advanced Editing — Try It!

+ Open tstep.f90 and retype the last loop nest

+ Use the code template to complete the do-loops

+ Use content assist to complete variable names
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Custom Code Templates

(Fortran)

+ Customize code templates in Window »
Preferences » Fortran » Templates

e OO0 Preferences
type filter text Templates =1 v w
P General )
» Ant Create, edit or remove templates:
PC/C++ Name Context Description New...
P Dynamic Languages @] allocate (...) Fortran Allocate statement (lower case)
VFortran @ ALLOCATE (...) Fortran Allocate statement (upper case) Edit

CDT Integration ™ call ... Fortran  Call statement (lower case)
Editor ™ CALL ... Fortran Call statement (upper case)

# deallocate (...) Fortran Deallocate statement (lower case) Remove
> Help @ DEALLOCAT... Fortran Deallocate statement (upper case)
P Install/Update  do while...e... Fortran Do-while construct (lower case) A s

) Restore Removed

> Java V DO WHILE...... Fortran Do-while construct (upper case)
P JavaScript @] do...end do Fortran Do-loop construct (lower case)
» Parallel Tools # DO...END DO Fortran  Do-loop construct (upper case) Revert to Default
» PHP  forall...end... Fortran Forall construct (lower case)
P Plug-in Development (¥ FORALL...E... Fortran Forall construct (upper case) |
b Remote Systems # function...e... Fortran Function (lower case) R
> Remote Tools (¥ FUNCTION..... Fortran Function (upper case)
»Run/Debug M if then Fartran If-than ranctriict (lowar Faca) Export...

Service Configurations

+ Can import/export templates to XML files
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Refactoring and Transformation
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Refactoring

(making changes to source code that don’t affect the behavior of the program)

+ Refactoring is the research
motivation for Photran @ Illinois

T + lllinois is a leader in refactoring research

Refactor
Rename...

Extract Loca

L (Opdyke & Johnson, 1990)

+ We had the first dissertation...

Introduc

gncapsulate variable...

ke i E10 PHCCent. (Opayke, 1992)
seto . . .
Add ONLYOCJB'? List.. el + ...and built the first refactoring tool...
Minimize Variable Nameoﬁ‘:l’;':kt (Roberts, Brant, & Johnson, 1997)
M MM .
Make Cg\%variab'es to 0 + ...and first supported the C preprocessor
MoveS - (Unchecked)--- <0C (Garrido, 2005)
e , ]
interchand e q + Photran’s agenda: refactorings for HPC,
o o L - =
urify KeP L olete 0P language evolution, refactoring framework
Replac
ing
Debuggl . .
+ Photran 7.0: 31 refactorings
Module 3
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Refactoring Caveats

+ Photran can only refactor free form code that
IS preprocessed
+ Determined by Source Form settings

(recall from earlier that these are configured in
Project Properties: Fortran General»Source Form)

v Free Form, Unpreprocessed: .f08 .f03 .f95 .f90
% Free Form, Preprocessed: .FO8 .FO3 .F95 .F90
® Fixed Form: f fix  .for .fpp .ftn  .f77

+ Refactor menu will be empty if
+ Refactoring not enabled in project properties

(recall from earlier that it is enabled in
Project Properties: Fortran General»Analysis/Refactoring)

+ The file in the active editor is fixed form

+ The file in the active editor is preprocessed
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Rename Refactoring

(also available in Fortran)

+ Changes the name of a variable, function, etc.,

including every use
(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal

(aware of scoping rules, namespaces, etc.)

file Edit source [UEEERIY Navigate search proie 4 Switch to C/C++ Perspective

- - | Rename... Shift+Alt+R | .
& b ~ + Open a source file
¢ v v *o (ov Extract Local Variable Shift+Alt+L . .
: Extract Constant... Alt+C + In the edltor, C||Ck on a
.5 Project Explorer _ _ . .
Extract Function... Shift+Alt+M Va r|ab|e or fu nction name
In Java (Murphy-Hill et al., ICSE 2008): 4 Select menu item
Refactoring Uses Percentage Re'fa Ctor > Rena me
Rename . 179,871 74.8?/(
;lx(:i:l:ct Local Variable :;;g; ggé + O r use con text menu
Extract Method 10,581 4.4%
lCl;-angc Method Signature j?((;;l .'12(7):;( + E n te r n eW n a m e
Module 3  Extract Constant 3:36; 1:4% 3-116
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Rename in File

(C/C++ Only)

+ Position the caret

over an identifier. 206 time_unload(prv,nxt, tu_my_id,"
307 int prv;
308 int nxt;
+ Press Ctri-1 309 int tu_my_id;
(Command-1 on Mac). 310 int jstart;
311 int jend;
+ Enter a new name. 312 float  dvdt[n][m];
313 {
Changes are o 314 neighbour_send(nxt, tu_my.
propagated within 315 neighbour_receive(prv, tu.
the file as you type. 3o
318 /*
319 this 1s a general purpose funi
320 %/

321 neighbour_send(ns_neighbour,n:

322 int ns_neighbour;
323 int ns_my_id;
324 int ns_rec_id;
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Extract Function Refactoring

(also available in Fortran - “Extract Procedure”)

+ Moves statements into a new function, replacing the
statements with a call to that function

+ Local variables are passed as arguments

Changes to be performed a4 ’ v

V] 27 init.c - shallow

i Lafsn 4 Select a sequence of
C)‘fjginal Source ‘Rlefaciored Source

O e i i statements

2 e G0 L < v o e I + Select menu item

s 3 ) | Refactor»

e Extract Function...
S printfC'Shatiow water weather model - 1| /1207 PTIEBGMErO); |

zf;"Eigii.“.“”‘:" oF ot in X dire /31-} o 4+ Enter new name

< Back [ Next > | Cancel | l Finish l
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Introduce ImpLIiCcIT NONE Refactoring

+ Fortran does not require variable declarations
(by default, names starting with I-N are integer variables; others are reals)

+ This adds an IMPLICIT NONE statement and adds explicit
variable declarations for all implicitly declared variables

00 Introduce Implicit None + Introduce in a single file by
;nngesmbeperformea R opening the file and selecting
¥ @3 Introduce Implicit None H
Refactor»>Coding Style»
Introduce IMPLICIT NONE...
[ﬂ tstep.f90
Original Source Refactored Source . . .
e el e et @ |+ Introduce in multiple files by
implicit none’ — i i i
integer(kind=C_INT), \ inzegert:: i9 SeIeCtIng them In the PFO_]ECt
real ind=CFLIAD) integer :: j Explorer view, right-clicking on
) the selection, and choosing
Refactor» Coding
Style» Introduce IMPLICIT
< Back Cancel ' OK | N O N E nmnm
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Loop Transformations

(Fortran only)

+ Interchange LOOPS CAUTION: No check for behavior preservation
+ Swaps the loop headers in a two-loop nest

+ Select the loop nest, click menu item > >
Interchange Loops (Unchecked)...
8 00 Interchange Loops (Unchecked)
| Changes to be performed Y

@ ¥ &3 Interchange Loops (Unchecked)

v 28 tstep.f90 - shallow

@ tstep.fo0 /:h L@Z‘ 4{} R
Original Source Refactored Source |
l doi=1, m l do j = jstart+l, jend+l
62 do j = jstart+l, jend+l 62 doi=1,m
pnew(1,3j) = pold(i,j) + tdt 63 pnew(i,3j) = pold(1,3) +
64 unew(i,j) = uold(i,j) + tdt 64 unew(i,3j) = uold(i,j) +
65 vnew(i,3j) = vold(i,j) + tdt 65 vhew(i,3j) = vold(i,j) + -
end do 66 end do
end do 67 end do
Old version traverses New version traverses
matrices in row-major order in column-major order
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Loop Transformations

+ Unroll Loop
+ Select a loop, click Refactor»Do Loop»Unroll Loop...

do i =1, 12
print *, 10*1
end do
Unroll 4 x
do 1 =1, 12, 4
print *, 10*1
print *, 10* (i+1)
print *, 10*(1+2)
print *, 10* (i+3)
end do

Module 3

(Fortran only)

G tstep.fo0

Original Source

! Don't apply time filter on first
70 1if ( firststep == @ ) then
71 do j = jstart+l, jend+l
72 doi1=1, m

73 pold(i,j) = p(i,j)+alpha*(pne
74 uold(i,3) = u(i,j)+alpha*Cune
75 vold(i,j) = v(1,j)+alpha*(vne
6 end do
end do
end if

20 do j = jstart+l, jend+l

(81 doi=1, m
82- p(i,3) = pnew(i,j)
83 u(i,j) = unew(i,j)
84 v(i,j) = vnew(i,j)
85 end do

end do

27-end subroutine

Refactored Source

end do
end if

l}g }_&\ AJ}

|81 do j = jstart+l, jend+l
82 loopUpperBound = m

do 1 = 1, loopUpperBound,4

p(i,3)

85 u(i,j)

v(i,3)

pnew(1,3)
unew(i,j)
vnew(i,3)

p((i+1),3) = pnew((i+1)
u((i+1),3) = unew((i+1)
v((i+41),3) = vnew((i+1)

90 p((i+2),3) = pnew((i+2)
91 u((i+2),3) = unew((i+2)

)2 v((i+2),3) = vnew((i+2)
)3 p((143),3) = pnew((i+3)

u((i43),3) = unew((i+3)

end do
end do
)2 end subroutine

ﬁ; v((143),3) = vnew((i+3)
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Refactoring & Transformation — Try It!

In tstep.f90...

1. In init.c, extract the printf statements at
the bottom of the file into a new function
called print banner

2. In worker.c, change the spellings of
neighbour send and neighbour receive
to American English

3. In tstep.f90, make the (Fortran) tstep
subroutine IMPLICIT NONE
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Module 4: Other Tools and
Wrap-up

+ Objective
+ How to find more information on PTP
+ Learn about other tools related to PTP
+ See PTP upcoming features

+ Contents
+ Links to other tools, including performance tools
+ Planned features for new versions of PTP
+ Additional documentation
+ How to get involved
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BANESA  HpC Workbench

+ Tools for NCSA Blue Waters

+ http://www.ncsa.illinois.edu/BlueWaters/
+ Sustained Petaflop system

+ Based on Eclipse and PTP

+ Includes some related tools m WAI[HS

SUSTAINED PETASCALE COMPUTING .
4+ Performance tools S

+ Workflow tools (https://wiki.ncsa.uiuc.edu/

display/MRDPUB/MRD+Public+Space+Home
+Page)

+ Part of the enhanced computational environment
described at:

http://www.ncsa.illinois.edu/BlueWaters/ece.html
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NSF SI2 Workbench for High
Performance Computing

+ 11
for HPC Applications”, which is supported by the National
Science Foundation under award number OCI 1047956

+ Produce a productive and accessible development
workbench using Eclipse PTP

+ Key Components
+ Determining Requirements, Ensuring Impact
+ Make improvements to Eclipse PTP
+ Engineering Process
+ Metrics
+ Outreach/Training/Education
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Coding & NCSA HPC Workbench .+

nalysis . 4 _
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Planned PTP Future Work

+ Scalability improvements
+ UI to support 1M processes
+ Very large application support
+ Usability improvements
+ New wizard to improve setup experience
+ Ability to share configuration information
+ Resource Managers

+ More implementations of configurable resource
managers

+ Synchronized project improvements
+ Conversion wizard

+ Resolving merge conflicts
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Useful Eclipse Tools

+ Linux Tools (autotools, valgrind, Oprofile, Gprof)
+ http://eclipse.org/linuxtools
+ Python
+ http://pydev.org
+ Ruby
+ http://www.aptana.com/products/radrails
+ Perl
+ http://www.epic-ide.org
+ Git
+ http://www.eclipse.org/egit
+ VI bindings

+ Vrapper (open source) - http://vrapper.sourceforge.net
+ VviPlugin (commercial) - http://www.viplugin.com
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Online Information

+ Information about PTP

+ Main web site for downloads, documentation, etc.
+http://eclipse.org/ptp

+ Wiki for designs, planning, meetings, etc.
+http://wiki.eclipse.org/PTP

+ Articles and other documents

+http://wiki.eclipse.org/PTP/articles

+ Information about Photran

+ Main web site for downloads, documentation, etc.

+http://eclipse.org/photran
+ User’ s manuals

+http://wiki.eclipse.org/PTP/photran/

documentation
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Mailing Lists

+ PTP Mailing lists

+ Major announcements (new releases, etc.) - low volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-announce

+ User discussion and queries - medium volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-user

+ Developer discussions - high volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-dev

+ Photran Mailing lists

+ User discussion and queries
+ http://dev.eclipse.org/mailman/listinfo/photran

+ Developer discussions -

+ Also on ptp-dev list (see above)
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Getting Involved

+ See http://eclipse.org/ptp

+ Read the developer documentation on the wiki
+ http://wiki.eclipse.org/PTP

+ Join the mailing lists

+ Attend the monthly developer meetings

+ Conf Call Monthly: Second Tuesday, 1:00 pm ET
+ Details on the PTP wiki

+ Attend the monthly user meetings

+ Teleconf Monthly: 4t Wednesday, 1:00 pm ET
+ Details on the PTP wiki

PTP will only succeed with your participation!
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